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1  Introduction
1.1  Dimensioning of electrical networks with SIMARIS design
With SIMARIS® design it is possible to dimension electrical netw orks from medium voltage to the w all outlet on the basis of real products, in

compliance w ith all the relevant standards (VDE, IEC) and reflecting the present state of the art.

Within the scope of the specif ications required for the calculation, netw ork operating modes and sw itching states can be freely defined. Short-

circuit current, load f low , voltage drop and energy balance are calculated. The requirements as to personal, short-circuit and overload protection

are also automatically included in the calculation. Dimensioning also includes the busbar trunking systems required for pow er transmission. It is

also possible to dimension complete motor starter combinations.

The professional version of SIMARIS design additionally provides the follow ing options:

n Dimensioning of netw orks w ith parallel netw ork operation, also w ith simultaneous operation of transformers and generators 
n Automatic selectivity evaluation

n Representation of isolated netw orks

n Passive and active changeover in the emergency pow er supply

n Consideration of energy eff iciency aspects w ithin net planning

1.2  System requirements
The follow ing equipment is required as minimum to run SIMARIS® design:

n Processor: Intel Core i3 / AMD Phenom II X4 
n 4 GB RAM

n Free hard disk space: 400 MB (if a country is selected) up to 2.5 GB (if  all countries are selected)

n Screen resolution

- Format 4:3: 1280x1024 (recommended 1400x1050)

- Format 16:9: 1366x768 (recommended 1680x1050)

n Supported operating systems: Window s 7, Window s 8

n Supported MS-Office versions: Off ice 2007, Off ice 2010

1.3  Setup instructions
1.3.1  Setup from DVD
n Close all other applications on your computer. 
n Insert the SIMARIS DVD into the DVD drive and start setup.exe.

n The setup w izard guides you through the installation and allow s not only the installation of SIMARIS design but also the installation of SIMARIS

project and SIMARIS curves. SIMARIS project is not available for all countries because of the product portfolio that is integrated in the

softw are, so that this program can only be installed if  you have selected one of the respective countries in the country selection.

n Follow  the instructions of the setup w izard.

n The installation of SIMARIS design can be implemented as local or as netw ork installation.

n After installation, please check w hether updates are available and install them. To check w hether updates are available, you can initiate a

query provided that your computer is connected to the Internet via Help menu  àto "Start Online Update", provided that your computer is

connected to the Internet. Then you can install available updates online. Another option is to use the Help menu  à "Dow nload Update

Package" to open the update page on the Simaris w ebsite, dow nload the update package and install it manually afterw ards. This w ebsite,

w hich provides updates for the SIMARIS planning tools, can also be accessed by clicking the w w w .siemens.com/simaris/update.

1.3.2  Setup after download
n Request a dow nload link at w w w .siemens.com/simaris/dow nload by entering and sending your data. 
n The dow nload link w ill be sent to you by e-mail. Having dow nloaded the zip f ile that can be accessed through this link, unpack it on the hard

disk of your computer and then start setup_sd60.exe.

n The setup w izard w ill guide you through the installation. 

n Follow  the instructions of the setup w izard.

n The installation of SIMARIS design can be implemented as local or as netw ork installation.

n After installation, please check w hether updates are available and install them. To check w hether updates are available, you can use the Help

menu  àto "Start Online Update", provided that your computer is connected to the Internet. Then you can install available updates online.

Another option is to use the Help menu  àclicking "Dow nload Update Package" to open the update page on the Simaris w ebsite, dow nload

the update package and install it manually afterw ards. This w ebsite, w hich provides updates for the SIMARIS softw are tools, can also be

accessed by clicking w w w .siemens.com/simaris/update.

31

31

31

31

http://www.siemens.com/simaris/update
http://www.siemens.com/simaris/download
http://www.siemens.com/simaris/update
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1.3.3  Registration
n The softw are may be used in a demo mode for 20 days after its installation. Only those days are counted on w hich you actually open the

program. In order to be able to use SIMARIS design permanently, you must register on the Internet at w w w .siemens.com/simaris/register.

Please enter your data there and request a licence by submitting the form. This licence w ill then be sent to you by e-mail w ithin half an hour. 
n If  you have obtained a SIMARIS design professional version, please ensure that you have your authorisation code at hand, since you w ill only

receive a licence offering the extended functionality of the professional version of SIMARIS design if  you have entered this authorisation code.

n The licence of the basic version of SIMARIS desgin entitles you to use SIMARIS design permanently, w ithout enabling the additional functions of

the professional version.

n As long as the licence key has not been read in, you w ill be asked w hether you w ant to read in the licence key now  during every program

start or respectively, w hether you w ould like to register now  or later. 

n Clicking the "Enter licence key" button starts the import process of your licence key. The brow ser opens w here you can set the f ile path of

your licence key and select the licence f ile identif ied by the f ile extension .lic-sd. As soon as you open this f ile, the licence f ile is read in and the

program is started.

n Clicking the "Register now " button automatically opens the registration page for the SIMARIS tools provided you are online. How  to proceed

from there w as decribed in the previous section.

n Clicking the "Register later" button takes you straight to the program, but you w ill again be prompted to register during the next program start.

n You can initiate the licence key import w hile the program is running using the Tools menu  à "Licence".25

http://www.siemens.com/simaris/register
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1.3.4  Setup and use of national versions
n In the setup w izard you can choose technology packages w hich you w ant to install from a country list.  

n On the one hand, this implies the language selection, because w ith each country selection the national language and English are installed as

languages. On the other hand, this also implies the installation of the technology package pertaining to the selected country, i.e. the product

range available for the country, the technology of w hich complies w ith the regulations and conditions of the respective country. It is possible to

select several countries w hich is above all necessary if  you are editing projects for different countries, because you should, of course, edit

each project w ith the relevant technology package only.

n If  you later w ant to edit a project for a country w hose technology package / language is not installed, this can be made up for w ithout any

problems by restarting the installation, selecting a country or several further countries and thus installing the required languages and

technology packages. All installed countries and, if  a country w as selected, also the associated languages are displayed for selection in the

program step Project definition . How ever, the program must be restarted after every change applied to the selection. Please note that you

must also reinstall any available updates, since the updates only install that part w hich belongs to the national versions already installed on

your computer. How  to check w hether an update is available and how  dow nload and install it, if  necessary, is described in the section Setup

from DVD  and Setup after dow nload .

n When having edited and dimensioned a project w ith a specif ic country setting and reopening this project w hile having made a different country

selection in SIMARIS design, the dimensioning and device selection of the previous country setting is kept f irst but might not go w ith the product

portfolio available in the new ly selected country or w ith the technology required there. It is therefore absolutely necessary to restart

dimensioning so that the technology and product selection relevant for this country is made.

n When editing projects for various countries, the national language and English are each provided for editing. This means, for example, that you

can edit the project in English but can change to the national language for documentation purposes. Or you can send the project f ile to the

country and the editor there can open and edit the project in the national language.

38

5 5
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2  Program Interface and Structure
2.1  Overview of the program sequence
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2.2  Navigation bar / workflow bar
With the help of the navigation bar you can go to the desired program step by directly clicking it.

Project definition

 

In this program step, you can enter master and customer data and change the regional settings as w ell

as the technical settings of the medium- and low -voltage side.

Network design

In this program step, the actual netw ork is designed, electrical equipment is selected and these

elements are dimensioned either automatically or manually.

Project output

 In this program step, you can create various output variants to document your project, w hich you can

print out, save as f iles and also post-edit in parts. SIMARIS design professional moreover provides the

option to export a transfer f ile for import in SIMARIS project.

2.3  Icon bars
2.3.1  Main window

Create new  project Cut

Open project Copy

Save current project Copy element

Save current project as ... Paste

Delete circuit
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2.3.2  Network design

The tool bar in Netw ork design is divided into 11 sections relating to the various functionalities, e.g. editor functions, graphical netw ork editing,

dimensioning, etc. This allow s for fast and easy editing. All settings and options resulting from this w ill be described in detail in the follow ing.

2.3.2.1  Network diagram in a separate window

 

Move netw ork

diagram to separate

w indow

Clicking this icon opens a new  separate w indow  in w hich only the netw ork diagram and the corresponding tool bar are

displayed. This w indow  can then be dragged onto a second monitor to get a better overview  w hile editing. If  you w ant

to see the netw ork diagram w ithin the original program w indow  again, click this icon again to disable the function.

2.3.2.2  Selecting elements and browsing the network diagram

Selection tool

Having clicked this icon, you can select elements of existing objects in the netw ork diagram, so that their properties are

displayed at the bottom left next to the netw ork diagram. At the same time, any still active element from the library is

deactivated.

 

Brow se ...

This icon opens a search w indow  in w hich you can search for items of equipment w ithin the netw ork or project

structure according to various criteria.

n In the "Status" section you can check w hether all items have been dimensioned w ithout error or w hether there are

still any notes or errors left. 
n In the "Netw ork" section the netw ork structure is represented as a tree.

n In the "Type" section, elements of the netw ork diagram are listed sorted by circuit type, e.g. main distribution

boards, feed-in paths, couplings, sub-distribution boards....

n In the "Final circuits" section, the f inal circuits contained in the netw ork diagram are listed, sorted by the type of f inal

circuit, e.g. dummy load, capacitor, motor...

n In the "Selectivity" section, the elements of the netw ork diagram are sorted according to the criterion of full or partial

selectivity. This section, how ever, is only available in the professional version.

n In addition, you have a text search option, i.e. you can search the designation of a netw ork diagram element.

Having entered the desired text in the appropriate line in the search w indow , the list w ill be reduced to those

circuits that contain the search w ord.

When you mark the desired element in the results list (the corresponding part is highlighted in blue in the list), the

corresponding element on the netw ork diagram w ill be marked w ith a blue frame.
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2.3.2.3  Operating modes

Set operating

modes

This icon sets the required operating modes.

A new  w indow  is opened in w hich the position of the infeed and coupling sw itches (open or closed) can be defined

by clicking the sw itch w ithin the feeder supply management graphic.

The various operating modes that are required, e.g. normal operation and emergency operation, are defined by

duplicating an existing operating mode. To do so click the corresponding button and then define the required states of

the sw itches for the new  operating mode and change the designation of the operating mode. Non-permissible

combinations of sw itch positions are documented by red error messages, e.g. , in
the operating-mode diagram. How ever, the defined sw itch positions and netw ork operating modes are not show n in

the netw ork diagram but are graphically represented in the project documentation.

Operating modes can be activated / deactivated. In the netw ork diagram only the data for active operating modes is

show n. If the dimensioning is started again, the netw ork is dimensioned only on basis of active operating modes.

In the follow ing cases, dimensioning is impossible or does not deliver any result:

n Parallel infeed via a general coupling (only applies to the basic version) 
n More than one pow er source at the target distribution board on the sub-distribution level w ith directional coupling 

(only applies to the professional version)

n Pow er sources not connected into the system

For further information on this subject, please refer to the section Dimensioning and message list  in this Help.102
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2.3.2.4  Dimensioning

 With these icons the project can be dimensioned differently depending on the requirements.

 

Dimension all

circuits

Using this icon the entire project can be dimensioned.

 

Dimension

selected circuit

This icon serves for dimensioning the selected circuit and all elements contained therein.

 

Dimension

selected circuit

Using this icon the selected circuit and all dow nstream circuits connected to it are dimensioned. Dimensioning is,

how ever, not performed across couplings in this case.

For further information on the dimensioning process, please refer to thechapter Dimensioning and message list  in this Help.102
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2.3.2.5  Network diagram views

 These icons activate the set of view s available in this program. The netw ork diagram is displayed according to

the selection made, i.e. the parameters pertaining to the selected view  are displayed next to the individual elements of the netw ork diagram.

 

Netw ork diagram

w ith device

parameters

This icon is active by default. In this view  the follow ing parameters are displayed for the elements of the netw ork

diagram:

n Automatically generated element designation w ith consecutive numbering 
n Brief description of the elements

n Depending on the type of element, further data is displayed, e.g.

- rated current of the element

- length of the element

- reactive pow er of the element

- rated voltage of the element

- cable cross sections

- MRPD

- number of poles.

 

Netw ork diagram

w ith load f low  / load

distribution

This icon activates a view  in w hich not only the designation and MRPD of the elements on the netw ork diagram are

displayed but also parameters such as

- pow er

- pow er factor cos j
- voltage percentage at this point in the netw ork

- summated voltage drop in percent

- simultaneity factor

- permissible operating current of a connecting line lz

- operating current lb

and further technical data.

 

Netw ork diagram

w ith short-circuit

load

Clicking this icon displays not only the name and MRPD of the elements on the netw ork diagram but also the minimum

and maximum short-circuit currents as w ell as further information on the short-circuit strength.

Attention: Minimum and maximum short-circuit current are displayed w ith reference to the number of poles an element

has, e.g. for a single-pole load Ik 1 min and Ik 1 max are displayed.

 

Netw ork diagram

w ith energy report

By activating this icon, the follow ing information is displayed at every main distribution, sub-distribution and pow er

consumer: 

- apparent pow er

- active pow er

- reactive pow er

- rated apparent pow er

- loaded phase conductors.

Netw ork diagram

w ith user-defined

labelling

If you need your ow n, individual label configuration of the netw ork diagram, you can compile such individual labelling

using the Tools menu  à "Settings" à "Configurable netw ork diagram output". This variant of labelling can be

displayed in the program step "Netw ork design" and can be output as a user-defined view  in the program step "Project

output", as described in the section Output types .

Only for the China country setting: Within this individual configuration, DI types can also be selected for the netw ork

diagram labelling.

2.3.2.6  Selectivity

 

Selectivity 

view

n This icon opens a new , separate w indow  w ith the selectivity view . But it is necessary to select an element/sw itching

device in the netw ork diagram first, w hose characteristic curves and setting options w ill then be displayed. 

n If  the settings of the elements are changed via the regulators displayed on the left of the selectivity view , the

characteristic curve in the graphic on the right is synchronously adapted. These changed settings are saved, but only

until automatic dimensioning is started, w hich then overw rites these values according to the dimensioning results that

w ere gained. 

n  If  you w ant to specify the manually selected settings permanently, you can click on the key symbol show n to the

right of the slider, thus enabling it. In this case, the specif ied values w ill not be overw ritten during re-dimensioning, they

are retained. Devices w here settings w ere made accordingly are identif ied in the netw ork diagram by a key symbol.

n Further elements can be set by selecting the elements in the netw ork diagram one after another, because the selectivity

view  alw ays displays the characteristic curves of the elements currently selected in the netw ork diagram in the

corresponding circuit.

25

109
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n If  a protective device w as added to a circuit both dow nstream and upstream of the cable/busbar, the tw o device curves

are show n in blue (at the beginning of the cable/busbar line) and in green (at the end of the cable/busbar line), including a

tolerance band. 

n The envelope curves of the upstream devices (referred to the protective devices under consideration) are show n in red,

the dow nstream ones are show n in grey.

n The tw o vertical curves indicate the minimum and maximum short-circuit current at this point.

n The pink characteristic curve show s the selectivity limit, meaning the short-circuit current up to w hich the protective

device under consideration is selective (current discriminating) to the upstream device. If  a higher short-circuit current

f low s, the upstream device, too, or both devices can trip.

n The curve colours described above reflect the basic setting for the selectivity diagram. You can, how ever, adjust the

colour settings for selectivity diagram curves using the Tools menu à Settings àSelectivity Settings à I-t diagram screen

colours according to your ow n colour scheme. The legend displayed at the top right in the selectivity diagram describes

the curve colours of the currently show n diagram.

n In order not to w ipe out the curves in the selectivity diagram, the legend can be set in such a w ay using the Tools menu 

à Settings àSelectivity Settings that it is automatically minimized and is only show n enlarged/legible during mouseover.
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2.3.2.7  Paper size

Set paper size

Via the pull-dow n menu of the Set paper size icon you can choose from seven predefined paper sizes and the option

to specify a user-defined paper size.

The currently set paper size is displayed in the icon on the tool bar using the symbols from the menu.

The predefined paper sizes are each provided w ith a draw ing frame, w hereas the user-definable paper size is not. 

The paper size selected for the overall diagram in this program step should be selected in such a w ay that the lettering

is still legible, depending on the size of the netw ork diagram. In the case of large netw ork diagrams it is possible - also if

selecting a large paper size - to split the printout into several smaller pages w hich can then be pieced together again

like a jigsaw  puzzle. This is necessary, for example, if  no printer is available for printing the large paper size.

If "Define page format" is selected from the pull-dow n menu, a separate w indow  opens for entering the user-defined

settings for the page format. Here, the w idth and height of the desired page format can be entered in mm; the values

can range from 100 mm to 5,000 mm.

Via the menu item "Reload frame" you can load your ow n draw ing frame. After this menu item has been selected, the

brow ser is opened and you can select a f ile in .dxf or .dw g format, w hich is then displayed as draw ing frame in the

graphic area and can be used to edit a project.

Via the menu item "Changes" you can add a title block for a change index at any position in the netw ork diagram. 

As soon as you have placed the small table in the diagram, e.g. by clicking the left mouse button, a w indow  opens for

entering the data. When you click"OK", the data that w as entered is automatically transferred to the change index in the

diagram. 

The change index can be edited and extended using the context menu, w hich opens as soon as the mouse pointer is

placed on the change index in the graphic and the right mouse button is pressed.

Here you can do the follow ing w ith the change index:
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n Expand it by one line, i.e. add a new  entry 
n Edit it, i.e. change existing entries

n Move it to a suitable free space on the graphic

n Delete it.

2.3.2.8  Scale up / Scale down

Scale up / Scale dow n

With the scale up and scale dow n icons the size of the elements in the netw ork diagram can be changed in

relation to the page size. Therefore, it is not a zoom function but a real resizing. Starting from the preset original

size, the elements can be scaled dow n by a maximum of six stages and theoretically scaled up endlessly. The

thus set size w ill be applied to all elements of the netw ork diagram and w ill also apply w hen placing further

elements.

ATTENTION: 

Especially when scaling down elements, this setting is to be checked with regard to the legibility

of the data on the printout, because the legibility might vary greatly depending on the printer.

2.3.2.9  Align

 

For the vertical alignment of main and sub-distribution boards, the follow ing options are provided:

Left alignment, the element selected farthest on the left serving as reference point.

Vertically centred alignment, the w eighted centre of all selected elements serving as reference point.

Right alignment, the element selected farthest on the right serving as reference point.

For the horizontal alignment of selected elements, the follow ing options are provided for aligning the selected elements:

At the level of the top (selected) element.

In the w eighted horizontal centre of all selected elements.

At the level of the low est (selected) element.

To align a main or sub-distribution board to an upstream distribution board, it is possible to align the starting and end point of the connecting line

betw een the tw o distribution boards

vertically

horizontally.

Selected elements can be distributed evenly. The respective outermost elements of the selection are set as reference points and, at regular

intervals, the elements in-betw een are

 

aligned horizontally. 

aligned vertically.
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2.3.2.10  Zoom functions

 

Zoom selection

When this icon is clicked, the mouse cursor changes into a crosshair in the netw ork diagram, w ith the help of

w hich the area to be zoomed can be selected by draw ing a frame around it.

 

Zoom netw ork diagram

With this icon, the displayed cut-out of the netw ork diagram can be set in such a w ay that all elements are

displayed as large as possible, i.e. the display is limited by the outmost elements of the netw ork diagram.

 

Zoom output format

With the help of this icon, the view  can be reset to the selected paper size, i.e. to the full view  of this format.
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2.3.2.11  Quick view of calculation results

If  the quick view  of calculation results is activated on the tool bar, it is possible to call up a w indow  w ith the

calculation results for each dimensioned item of equipment by placing the mouse pointer on the desired item

of equipment.
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2.4  Menu bar and key combinations

2.4.1  File menu
In the File menu, select 

n New to create a new  project. 
n Open …to open an existing project w ith the f ile extension .sd.

n Save settings to save an existing project.

n Save as… to save an existing project in any directory under any name.

n One of the listed projects edited last to continue editing it. By default, the

last 4 edited projects are provided for selection. Using the Tools menu à
Settings à Editor settings, this number can be increased to 9.

n Exit to close SIMARIS design.

Note: While a project is opened or buffered, a backup copy of the project is

saved under the same name as the original project but w ith the extension .bak.

This f ile can be found in the same directory in w hich you saved your project. It

serves for restoring the original state or the last saved state of a project in the

event of a fault.
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2.4.2  Edit menu
In the Edit menu, select 

n Undo to undo the last editing step. By default, the last 20 editing steps can be undone.

Using the Tools menu à Settings à Editor settings, this number can be increased to 100. 
n Restore to restore the editing steps w hich have been undone. 

To be able to track the Undo and Redo editing steps, the respective last step is show n

directly in the menu w ith its short name.

If the project is saved during the editing process, the saved editing steps are retained for

Undo and Redo operations, i.e. they can still be used. Only w hen the project is closed, they

w ill be deleted, so that they are no longer available for editing w hen the project is called up

again.

How ever, Dimensioning of a project cannot be undone. Conversely, this also means that as

soon as dimensioning is being carried out during an editing process, the saved editing steps

are reset.

n After having selected the elements to be edited, select Cut, Copy, Copy element or

Paste to use the corresponding functions for editing. You can also access these functions

using the tool bar for netw ork design in the Main w indow  via identical icons or by using

the cotext menu (right mouse button). 
The difference betw een the "Copy" and "Copy element" function is that "Copy" allow s to

copy complete circuits, e.g. distribution boards and f inal circuits, w hereas "Copy element"

only allow s to copy individual circuit components, such as cables/lines or devices.

A description how  these circuits and elements saved on the clipboard can be inserted at a

different position on the netw ork diagram can be found in the section Graphic editing of

elements .

n Delete to remove elements. This can also be done using the same icon saved in the tool

bar in Netw ork Design. 
n Choose Select all to select all elements placed in the diagram for further editing.

9
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n Align to align the elements in the netw ork diagram according to your requirements. A

submenu is opened w hich contains the same functions for aligning the diagram as the

corresponding icon in the Netw ork Design tool bar in the section Netw ork design . 
n Layout lines to subsequently move a line in the netw ork diagram keeping the left mouse

button pressed. The new ly selected line layout can be frozen using the right mouse button

(context menu) by selecting "Block line" and this freeze can be undone again in the same

w ay (by selecting "Unblock line").

n If  the selected line layout is not frozen, it w ill not be available any more after having saved

and recalled the project, because in this case all lines w ill be recreated according to the

rules provided. How ever, only those lines / line sections can be moved w hose end or

break points are not f ixed. The starting and end points of the lines are usually f ixed

through the position of the items of equipment in the netw ork diagram so that they can

only be displaced by moving the respective item of equipment.

n Browse ... to search for items of equipment w ithin the netw ork or project structure

according to various criteria in the search w indow  w hich is now  displayed. 

2.4.3  Dimensioning menu
In the Dimensioning menu you can set the required operating modes as w ell as the

various options for dimensioning a netw ork, w hich are also each described by

reference to the icons on the Netw ork Design tool bar in thechapter Dimensioning   

2.4.4  View menu
Using the View  menu, you can

n select the various view  options for the netw ork diagram 
n open the w indow  to display Selectivity, w hich at the same time displays

the colour marking for selectivity evaluation in the netw ork diagram (this

is only available in the professional version).

n enable the Quick view of calculation results 

n select the desired Zoom function 

n select the Paper size  

n scale up/dow n the network diagram

n align the network diagram. .

For a detailed description of these functions/options, please refer to the

previous chapter Main w indow  of this Help (Icon bars) under the

corresponding icons.

10
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2.4.5  Energy Efficiency menu
In the Energy Eff iciency menu, you can use the menu item Power

loss to open a dialogue for view ing the pow er losses determined

for selected devices. This function is, how ever, only available to

users of the SIMARIS design professional version.
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In this dialog all circuits of the netw ork diagram are listed, sorted in

descending order based on the magnitude of their absolute pow er

loss. In further columns the apparent pow er and the relative pow er

loss of the circuits are listed as w ell. The accumulated length show s

the distance betw een the relevant circuit and the main distribution for

the operating mode selected.

Besides being sorted according to absolute pow er loss, the list can

also be sorted either according to apparent pow er or relative circuit

pow er loss. To do so, left-click on the corresponding column header.

As soon as the circuit w as selected in the table (now  highlighted in

blue), ist composition and the components contained therein as

show n in the grey f ield on the right. In addition the pow er losses of

the components in this circuit are displayed, i.e. the absolute pow er

losses of cable connections, busbar connections and devices.

The circuit selected in the list is also marked w ith a blue frame on the

netw ork diagram.

How ever, the energy effciency analysis only considers the

transformers and the low -voltage side of the netw ork diagram, so

that the medium-voltage side components possibly displayed for

feeding circuits arenoconsidered and/or listed.

The entire list of pow er losses of all circuits can be exported as .csv

file using the "Start Export (*csv)" button, so that it can be post-

edited separately and used for documentation purposes.

The "Change Device" buttons displayed for each circuit component

can be used for change technical details of the component.
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For example, increasing the rated pow er of a transformer allow s to

reduce the absolute pow er loss.

If you w ould like to keep the changed technical data in case of circuit

re-dimensioning, you must exclude your selection from automatic

dimensioning (remove the checkmark at the top).

The respective component w ill then be marked w ith a padlock

symbol (on the netw ork diagram, too) and excluded from a re-

dimensioning cycle of the entire netw ork or sub-netw orks.

The absolute pow er loss of the component w hich w as established

after the selection w as changed w ill immediately be displayed in the

pow er loss overview  as soon as you close the dialogue box.

In a similar w ay, you can adapt the technical data of other

components in these dialogues to reduce pow er losses, e.g. a

higher rated current can be selected for sw itching devices.

But please keep in mind that such a selection can produce notes and

error messages, w hich w ould be show n below  the netw ork

diagram. To eliminate such notes and errors, you must adjust the

technical data of other components either by an automatic re-

dimensioning cycle or by manual input for individual components. 

More information about energy eff iciency reports in SIMARIS design

can be found in the Technical Manual for the SIMARIS softw are tools,

w hich you can access using the Help menu  à "Technical manual".31
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2.4.6  Tools menu

Favourites

Select Favourites to call up various edit options for the favourites you

saved for infeed, distribution board and f inal circuits.

n Add favourite... 
n Edit favourites...

n Load favourites...

n Import favourites...

n Export favourites...

n To add a favourite, select the required elements in the netw ork

diagram and then select Tools menu à Favourites à Create

favourite... . The w indow  displayed on the left opens, in w hich you

can enter a name and description of this favourite. By clicking the

"OK" button, this data is saved together w ith the favourite. The

favourite is automatically assigned to one of the 3 available

categories System infeed, Distribution board or Final circuits. The

naming of the favourites must be unique, i.e. it is not possible to save

a new  favourite under an existing name. The favourites f iles are

identif ied by the extension .sdt (= SIMARIS design template). 

n To edit existing favourites, select Tools menu  à "Favourites"

à"Edit favourites". Here you can f ind a list of all favourites currently

available. Clicking the "Edit button opens a w indow  for entering their

names and descriptions (see above). Enable the "Delete" button to

select one or more favourites for deletion. This step is f inally

executed, w hen you confirm the action by clicking "OK". 

n Using the Tools menu à Favourites à Load favourites..., complete favourites libraries are loaded. How ever, access to the currently used

favourites library w ill be deleted w hen doing this. This function is to serve for being able to change betw een different libraries, e.g. betw een a

library w ith items for 690 V netw orks and one for 400 V netw orks. 
n Using the Tools menu à Favourites à Import favourites..., favourites libraries can be imported. This means that the favourites from the

imported f ile are saved in addition to the currently existing favourites in the favourites library. If  one of the names of the imported favourites

already exists, the name of the imported favourite is modif ied automatically by adding an underscore and the low est available number and thus

becomes unique.

n Using the Tools menu à Favourites à Export favourites..., favourites libraries can be generated, i.e. all currently existing favourites are saved

in a library w hich can then be reactivated later using Tools menu à Favourites à Load favourites... .

25
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Licence

In the Tools menu select Licence to view  the data for your current softw are setup, such as version

number, licence setting (basic or professional), in a w indow  now  on display. In this w indow , you w ill also

find a button for triggering the import of the licence f ile. Licence f iles can be identif ied in SIMARIS design

by the extension .lic-sd.

Settings

In the Tools menu select Settings to view  and change the settings for the follow ing topics. Dependent on

the selection you made, the tree in the left part of the w indow  now  displays:

� Editor settings

� Draw ing frame

� Save settings

� Configurable netw ork diagram output

� Selectivity settings (user-defined and printer colours of the I-t diagram) 

� Update settings

Editor settings

n Here you can, for example, deactivate and reactivate the

professional mode if you have the professional licence. This is

required, for example, to be able to further edit projects from users

w ho do not use a professional version and to subsequently send

them back to these users again for further editing. If  projects w hich

w ere created in the basic mode are further edited in the

professional mode, they cannot be edited w ith a basic version any

more but only be read. 
n For specif ic input dialogues in the program the input limits of

technical data can be extended, i.e. an extended value range can

be activated and deactivated. This refers to 

� the minimum short-circuit capacity of medium voltage

� any entry of generators

� any entry of transformers

� the option to enter phase angles of the short-circuit currents

w hen defining neutral system infeed through short-circuit

currents.

n This w indow  also provides options to enable and disable

� the w arnings w hen deleting elements in the netw ork diagram or

favourites

� queries as to the type of lightning current/overvoltage protection

and prior to adding surge arresters

� the information displayed during dimensioning.

n Furthermore, it is possible to set the number of

� f iles relating to projects edited last that shall be displayed in the

File menu (default 4, maximum 9)

� editing steps to be saved (default 20, maximum 100), so that

they can be undone the Edit menu.

n With the "Reset" button you can reset all settings made to the

standard settings.

n The "Apply" button saves your changes permanently.
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Drawing frame

n In this w indow  you can replace the draw ing frames saved in the

program by your ow n draw ing frames. By clicking the "Brow se..."

button, the brow ser is opened and you can import your ow n

draw ing frames w ith a suitable page size in .dxf format. 
n Later you can delete these imported frames again by clicking the

red cross next to the respective frame. 

n In the same w ay, you can save a text f ield w hich is frequently

required or save a change index in .dw g or .dxf format and delete

it.

n With the "Reset" button you can reset all f ields to standard values

again; in this case, for example, you can reset the draw ing frames

to the default draw ing frames provided in the program.

n Clicking the "Apply" button saves all changes permanently, so you

can, for example, resort to those draw ing frames that you had read

into the program yourself.

Save settings

n Here you can set w hether a backup copy of the edited f ile is to be

created, and you can determine the intervals of automatic

intermediate storage. 

n  Using the "Reset" button you can reset all settings made to the

standard values.

n The "Apply" button saves your changes permanently.
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Configurable network diagram output

n The menu item "Configurable netw ork diagram output" allow s you to

create a user-defined variant for labelling the netw ork diagram. 
n These user-defined labels can be created in this w indow  for all

netw ork diagram elements, this also includes infeed and distribution

board circuits, sw itching and protective devices and components in

final circuits.

n To do so, f irst select the element from the the tree at the top left

corner for w hich you w ant to create a label.

n Below  the tree, this means at the bottom left part, all parameters

available for selection for this element w ill be immediately displayed.

n Select a parameter by clicking the arrow  key in the centre and

choose the parameters you require for labelling your netw ork

diagram as desired. These parameters w ill then be show n in the f ield

at the bottom right corner

n At the top right, you w ill see a preview  of the selected label for the

respective element.

n Clicking the "Apply" button saves this selection permanently, w hich

makes it available for other projects as w ell.

n The netw ork diagram w ith this configured labelling variant can be

displayed as current view  (Netw ork diagram view s ) in the

program step "Netw ork Design". In the program step "Project Output",

this view  can be exported individually (select "Current view ") or

together w ith the standard view s (select "All view s") for

documentation purposes. Export can be made in form of a PDF or

DWG/DXF file.

n If  you w ant to exchange the selected settings for the configurable

netw ork diagram output w ith other editors of the project or transfer it

to a different computer, you can export these settings to a f ile using

the "Export" button. The f ile extension for the export f ile is ".profile".

This f ile w ith the extension ".profile" can be read by another editor, or

respectively by another computer using the "Import" button and can

thus be used for further project editing and project documentation.

13
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Selectivity settings

n Selectivity evaluation w hich is available in the professional version 

only  can be enabled and disabled in this screen. 
n It is also possible to enable and disable hints on the selectivity

evaluation here.

n As a further device characteristic for the assessment of the

selectivity a common envelope curve of all upstream devices and a

common envelope curve of all direct dow nstream devices can be

displayed and hidden in the Selectivity w indow .

n If  selectivity evaluation has been enabled and a selectivity w indow  is

open, all sw itching devices of a netw ork are highlighted in colour in

the graphical representation of the diagram according to the follow ing

criteria:

� green: element is fully selective,

� yellow : element is partially selective,

� grey: element cannot be evaluated.

This can be interpreted as follow s: The behaviour of device

combinations regarding selectivity can only be established by testing.

 For those combinations marked as fully or partially selective,

appropriate testing is available, but not for the items marked in grey.

n Moreover, in this screen you can set the legend displayed in the

selectivity diagram (see above) in such a w ay that it is automatically

minimized. This means, the legend is alw ays show n minimized at f irst,

so that it doesn't overlay the curves on display. Only during

mouseover, the legend is enlarged and thus legible.
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I-t-Diagram screen colours

n In this screen the desired colour combinations of the envelope

curves, characteristics and selectivity limits (only available in the

professional version) can be defined individually. 
n Using the "Reset" button you can reset all settings made in the colour

assignments to the standard values.

n The "Apply" button saves your changes permanently.

Update settings

n Here, you can define w ether the program shall look for new

updates after each program start or not. 
n To ensure that your softw are is alw ays up-to-date, w e

recommend to enable the automatic update check.

n If  you decide to disable this option, you can still trigger such an

update check regularly by clicking the Help menu à  Check for

Updates.
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2.4.7  Help menu
In the Help menu, these menu items asssist you in obtaining more information or updates. Choose

n Help... to open this document and thus inform yourself about details of operation and use w hile you

are using the program. 
n Tutorial… to start a presentation w hich gives you an overview  of the program functionality divided

into several chapters and illustrated by many graphics and brief explanations.

n Technical manual… to get access to a PDF file w hich contains additional information about

SIMARIS design and SIMARIS project.

n Load demo project … to open a demo project.

n Key assist... to open a w indow  show ing a list of all key combinations available in the program, in

w hich you can search for the desired key combination by scrolling.

n Start online-update … to check w hether an update is available for SIMARIS design, w hich you

can… directly dow nload and install from the Internet..

n Download update package… to dow nload an update as softw are package (.zip f ile) and

decompress and install it manually.

n What's new?… to open a w indow  w hich displays all updates and functionality/data changes of

the latetest main version and lists all installed hotf ixes and updates together w ith a brief description.

n Info… to open a w indow  containing information about the softw are version installed on your

computer including the version status of all installed components and the data of the licence key

you are using.

2.4.8  Corresponding key combinations
The available stored key combinations can be used as follows:

+ (plus) Plusmeans that both keys are to be pressed, i.e. either both keys

are simultaneously pressed, or keep the f irst key pressed and press

the second key at the same time.

, (comma) Comma means that you must f irst press the first  key

combination, then release all keys, then press the second key 

and release it, if  necessary, press the third key etc.

Example: 

Set paper size to 

A3 portrait

Alt + P, 3, P

n Press the "Alt" key, keep it pressed and simultaneously press the

"P" key. A small w indow  opens in the bottom right corner of the

program, w hich lists all available paper sizes and the key

combinations required for their setting.  
n Release both keys and shortly press the "3" key to set the DIN A3

format. 

The f irst w indow  is closed and another small w indow  opens in

w hich the further available variants (portrait and landscape) are

displayed. 

n By pressing the "P" key, the paper size is converted to the desired

portrait size.

n All available key combinations can also be displayed in the program

itself by calling the corresponding list using the Help menu

 à"Key combinations" menu. An alphabetically sorted list w ill be

displayed at the bottom right of the screen w here you can look for

the key combination you need. 

n Moreover, the key combinations are also displayed in the

corresponding menus or w hen calling functions via the icons on

the tool bar, in addition to the labelling.
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The functions w hich can be called via the menus as w ell as via key combinations are labelled w ith the corresponding key combinations in the

menus. 
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Extract of the key combinations in SIMARIS design

Call / Change to program step Step - Netw ork planning Ctrl + 2

 + 

Step - Project output Ctrl + 3

 + 

Step - Project definition Ctrl + 1

 + 

File menu New  ... Ctrl + N

 + 

Open … Ctrl + O

 + 

Save settings Ctrl + S

 + 

Save as ... Ctrl + Shift + S

 +  + 

Exit Alt + F4

 + 

Edit menu Undo Ctrl + Z

+ 

Redo Ctrl + Y

 + 

Cut Ctrl + X

 + 

Copy Ctrl + C

 + 

Paste Ctrl + V

 + 

Delete Del

Select all Ctrl + A

 + 

Align F10
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Moving equipment w ithin network

diagram

Shift to the left Arrow  left

Shift to the left (big step) Shift + arrow  left

 + 

Shift upw ards Arrow  up

Shift upw ards (big step) Shift + arrow  up

 + 

Shift to the right Arrow  right

Shift to the right (big step) Shift + arrow  right

 + 

Shift dow nw ards Arrow  dow n

Shift dow nw ards (big step) Shift + arrow  dow n

 + 

Help menu Show  list of key combinations Shift + F1

 + 
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3  First Start
3.1  Call start wizard

When you start the SIMARIS design softw are, the start w izard opens

automatically.

3.2  Create new project
Select "Create a new  project". 

"Next" opens the w indow  for the project data.

Enter the master data on the project here. The entry of a project name and

project description is mandatory (default entry is "new "), the entry of all

other project data is optional.

"Next" takes you to the w indow  for entering the technical settings for

medium voltage.

Attention: The values to be used for medium voltage must be obtained

from the responsible pow er supply netw ork operator.
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In the last w indow  of the w izard, you can enter the technical settings for

low  voltage.

By clicking the "Finish" button, all preset values are applied and you are

taken to the Step 2, Netw ork design .

All of the data entered in the last three w indow s can be checked and

corrected, if  necessary, at a later stage during the project edit process in

Step 1, Project definition  since all entries and settings w ill be show n

there in form of a synopsis.

The entered values and selected quantities are saved w hen the program

is exited and used as defaults w hen the program is restarted.

10
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3.3  Open existing project
Select "Open an existing project" in the start w izard and then "Brow se..." to select a SIMARIS design f ile w ith the extension .sd. Clicking the

"Finish" button opens the SIMARIS design f ile.

Project f iles of versions 4, 5, 6 and 7 can be opened.

Note on the adjustment of the voltage factor at the low -voltage level

As of version 5.0 and higher the voltage factor cmax=1.1 in accordance

w ith Table 1 of DIN EN 60909-0 (VDE 0102):2002-07 is used for calculating

maximum short-circuit currents at the low -voltage level. This value cannot be

changed in the program interface and w ill be output in the project

documentation and Defaults / netw ork parameters table.

Therefore, w hen old projects of versions 4.0 and 4.1 are loaded, this info

w indow  is displayed.

3.4  Load demo project
Select "Load the demo project" in the start w izard. By clicking the "Finish" button the demo project is opened.

3.5  Tutorial
As soon as you click the "Show " button on the right next to "Tutorial", the presentation w ill be started, w hich gives you an overview  of how  to

handle the program.

You can also access the tutorial during the program w orkflow  using the Help menu  à "Tutorial" link.31
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4  Project definition
After a project w as loaded or created and the start w izard exited, w hich includes recording the data relevant for project definition, you w ill

automatically be taken to Step 2, Netw ork design . In order to view , complete or alter Project definition  data saved during this editing step

or any other project editing step, click

.

4.1  Project data
In an existing project, the master data, client data, regional settings and comment can be completed and changed in the Project definition. 

The entry of a project name and project

description is mandatory (default entry is

"new "). The length of the project name is limited

to 40 characters and the project short

description is limited to 19 characters.

The entry of the planner's name (default entry is

the Window s login name) and the design off ice

is optional and limited to 19 characters each.

This part of the screen also show s the creation

date of the project and the date of the last

change.

If you are editing a new  project on the basis of

an earlier project, modifying it according to the

new  requirements, it is possible to set the dates

for the creation of the plant and the last change

of the project to the current date by clicking  .
 

The location of the client project and the client's

name can be input as client data, each limited to

19 characters.

Regional settings of SIMARIS design are made

in the Project definition and are closely linked to

the installed country packages. This means that

by selecting a country, the respective

technology package, too, w hich comprises

suitable and technologically compatible products

for this country w hich are also regionally

available, is used for product selection and

automatic dimensioning w ithin the scope of

configuration.

For every country, its national language or

English can be set as language ("regional

setting"). 

Changing the language and/or the country only

becomes effective after a restart of SIMARIS

design. 

More than 60 countries w ith a total of 21

languages can be installed and specif ied for

SIMARIS design. A detailed list of all of the

available country settings can be found in the

setup document and on the Internet at 

w w w .siemens.com/simaris.
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Below  the regional settings, a f ield for entering

a comment on the edited project is displayed.

It is useful to w rite dow n some notes here that

document the boundary conditions for

dimensioning.

For example: 3 transformers feed to a busbar

by w ay of couplings. For operational purposes

a maximum of 2 transformers are coupled.

One transformer is available as backup.

Such a note in the documentation makes clear

that device/system dimensioning is made related

to the currents / short-circuit currents present

at 2 transformers.

4.2  Technical settings
The technical settings enable the user to

review  the data for medium and low

voltage w hich he set in the start w izard,

and, of course, to change them.

Changed settings w ill be saved and w ill

be available again after every program

restart.

If  technical data are changed w hile a

project is being edited, an immediate

check w ill be performed. How ever,

equipment w ill only be adjusted

accordingly once the project has been

redimensioned.

The picture on the left show s the

technical settings as originally delivered.

Attention: The values to be used for

medium voltage must be obtained from the

responsible pow er supply netw ork

operator.

Please define the reference point for

voltage drop calculation as required in

your project. When the option

"Transformer-secondary terminals" is

selected, the transformer's voltage drop is

not factored in the calculation, w hereas it

is factored in w hen "Transformer-primary

terminals" is selected, w hich may cause

the required values to be exceeded.
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5  Network design
5.1  Network design user interface
5.1.1  Overview
Netw ork design is the second step in the w orkflow . After the start w izard has been f inished, the program automatically changes to this view  and

is ready to create the project.

In this program step, the user interface is subdivided as follow s:

n Graphics w indow  w ith tool bar as main w orkflow  area 
A detailed description of the functions available on this tool bar can be found in the section Icon bars  under "Netw ork Design". This section

not only describes the functions for editing the netw ork diagram but also the option for dimensioning and setting the various netw ork diagram

view s (device parameters, load f low  / load distribution, short-circuit load, energy report).

n Message list (below  the graphics w indow )

the message list contains error messages, w arnings, hints and notes of diemensioning errors. An explanation of the meaning of the different

message types can be found in the section Dimensioning and message list  at "Message list".

n Library or Favourites or Graphic/symbols on the top left next to the graphics w indow

details are described in the section Library, Favourites, Graphic/symbols .

n Hints and Properties (middle to bottom left next to the graphics w indow )

Details are described in the section Hints  and Properties of circuit and equipment .

 Tool bar

 
 Library  

 Favourites  
 Graphic/symbols  

 Graphics window  

 Hints  

 Circuit properties  

 Properties of equipment  

 Message list  
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5.1.2  Library, Favourites, Graphic/symbols
n The library provides different versions of  

- system infeeds and couplings

- distribution boards

- f inal circuits

w hich can be used w hen creating a netw ork diagram.

n The icons are activated by clicking on them. Afterw ards, the activated element

can be inserted at the appropriate position in the netw ork diagram w ith a mouse

click.

n A detailed description of the individual elements made available by these icons

and their use in the netw ork diagram can be found in the chapter Overview  of

the icons library  Handling of Netw ork design.

n Under Favourites, the user can keep a selection of system infeeds,

distribution boards and f inal circuits in order to later include them in projects

to be edited. 
The functions to be used for editing favourites can be found in the Tools

menu à Favourites. These functions are described in the section Menu bar

and key combinations .

In addition, the creation and handling of favourites is described in more

detail in the chapter Overview  of the icons library  "Handling of Netw ork

design".

 When this button is activated, annotations can be added to the netw ork

diagram at the desired position by pressing the left mouse button. They can be

formatted as follow s in the w indow  that is now  displayed:

- font colour

- font size either by directly entering the font size or by setting it w ith the

regulator. 

Post-editing of added text f ields is possible. When the selection tool has

been activated, place the mouse pointer on the text f ield in the netw ork

diagram, call up the context menu w ith the right mouse button and select the

menu item "Edit annotation". Annotations can also be copied, cut, pasted

and deleted w ith the help of this context menu.

48
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n The three other buttons 

 allow  for adding

- lines

- circles or ellipses

- rectangles

to the netw ork diagram. To do this, f irst enable the desired button by clicking

it, then place the element at the desired position on the netw ork diagram by

pressing the left mouse button and zoom it up to the desired size by keeping

the left mouse button pressed.

With the help of the context menu that opens, w hen the mouse is placed on

a graphic to be edited and the right mouse button is pressed, these added

graphics can be

- copied or cut and then pasted again

- deleted.

 

Selecting the menu item Properties opens the follow ing w indow  in w hich

you can define the graphic style (e.g. solid, dashed or dotted line), the line

thickness and colour.
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5.1.3  Hints
Below  the library, a section w ith hints on the program handling is displayed depending on the respective situation. The follow ing are some

examples supporting you in familiarizing w ith w orking in the netw ork diagram:

n Hint in case of an empty netw ork diagram 

n Hint w hen adding an element 

n Hint w hen adding a normal (“general”) coupling 

n Hint w hen adding a directed coupling 

n Hint w hen editing the netw ork elements 
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5.1.4  Properties of circuit and equipment
n When selecting one of the circuits contained in the netw ork diagram w ithout selecting a specif ic item of equipment, the properties of this circuit

are displayed in the "Properties" section. 
n When selecting an item of equipment in the netw ork diagram, the properties of the circuit to w hich this item of  equipment belongs  are displayed

in the "Properties" section and below  that also the properties of the item of equipment itself.

These are examples.

n Example: Properties w hen selecting a circuit 

n Example: Properties w hen selecting a transformer 
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n Example: Properties w hen selecting a busbar line 

n Example: Properties w hen selecting a sw itch 
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n Example: Properties w hen selecting a load 

5.1.5  Tool bar

A detailed description of the functions and editing options in the netw ork diagram available on the tool bar can be found in the section "Icon

bars"à Netw ork design .

5.1.6  Graphics window
The graphics w indow  displays the netw ork diagram you created.

Graphic representation and labelling in the netw ork diagram can be

adapted to project requirements using the various functions provided

in the tool bar or the menus.

 When this icon is activated, you can cut the netw ork diagram

out of the program interface and display it in a separate w indow ,

meaning on a separate screen, too.

10
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5.1.7  Message list
Above the list, the total number of messages available is displayed and a symbol also indicates the status of all messages.

n Circuits are contained in the projects w hich w ere not or cannot be checked (e.g. unloaded circuits).  

n There are errors in the project. 

n All circuits w ere checked and there are no faulty circuits. Warnings, notes and dimensioning errors are not separately recorded

and associated to this node. 

The message list displays four types of messages:

n Error messages w hich result in abortion of the calculation / dimensioning process 

n Warning messages w hich indicate that default settings or standards have not been observed 

n Dimensioning errors w hich indicate an unsuccessful dimensioning process 

n Information messages w hich contain general information or hints 

Further explanations of the interpretation and handling of messages can be found in the section Dimensioning and message list  à
Message list .
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5.2  Handling of Network design
5.2.1  Overview of the icons library

The icons library contains the icons available for the creation of the

netw ork diagram, sorted in the categories

n System infeed / Coupling 
n Distribution board

n Final circuits

The icons can each be selected w ith a mouse click and then placed at the

desired insert position in the netw ork diagram w ith the mouse.

Netw ork design alw ays starts w ith the creation of an infeed element and

never w ith a coupling. 

Suitable insert positions for further elements are indicated by orange

squares w hich are, how ever, only displayed w hen moving the mouse

pointer along the connections (busbars displayed in green or lines

displayed in blue). 

To create further netw ork elements in the diagram, click the left mouse

button at one of these insert points, keep the mouse button pressed and

drag the mouse pointer aw ay from the insert point. When releasing the left

mouse button, the insert w izard of the respective element opens. The

fields show n by this w izard must be f illed in completely and must not

contain any w arning messages any more (identif ied by ) so that your

entries can f inally be completed by clicking the Finish button.

This insert w izard only permits the definition of basic properties and

technical data on the infeeds, couplings, distribution boards and f inal

circuits that w ere added. To view  and change detailed data on the

corresponding equipment after adding it, place the mouse pointer on th

respective item of equipment, call up the context menu w ith a right mouse

click and select the menu item "Properties" from the w indow  w hich is then

displayed, for example

n the default for the transformer capacity for transformers 
n define the installation type and cable cross sections for cable

connections

n define in detail the types of protective devices to be used

These equipment dialogues for the components of infeeds, couplings,

distribution boards and f inal circuits are described in more detail in the

section Properties of circuits and equipment .

5.2.2  Adding elements to the network diagram

5.2.2.1  Adding system infeeds and couplings
There are 5 types of system infeeds or couplings provided for selection that can be used in the netw ork diagram:

n Transformer w ith medium voltage 

n Transformer w ithout medium voltage

n Generator

n Neutral netw ork infeed

n Busbar section w ithout source

n Coupling

5.2.2.1.1  System infeeds

To add the f irst infeed to the netw ork diagram, or any additional infeed independent of existing ones in order to create an isolated netw ork, select

the icon of the required infeed in the library, choose an appropriate position in the netw ork diagram w ith the mouse and place the infeed there

w ith a click of the left mouse button. To add further infeeds as parallel infeeds to existing ones, select the icon of the desired infeed in the library,

search for an appropriate insert point in the netw ork diagram w ith the mouse (yellow  rectangle), and insert the infeed by pressing and holding the

left mouse button, then dragging the mouse aw ay from the selected insert point and f inally releasing the mouse button.
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After an infeed w as added to the netw ork diagram, its insert w izard opens in w hich basic settings can be made. Please note the follow ing for the

data selection:

n The data items available for selection are each provided in drop-dow n menus. 
n For lengths, e.g. of the medium-voltage cable or the low -voltage connection (cable/w ire or busbar), input values from 0.1 to 10,000 m are

permissible.

n When selecting the type of system configuration and w hen selecting a busbar system on the low -voltage side, additional information can be

displayed in the insert w izard via the corresponding info buttons. 

n A sw itching device upstream or dow nstream the connecting line must be selected at the low -voltage side.

n In case you enabled the query regarding lightning current and overvoltage protection, you have to define w hether you w ant to configure

lightning current and overvoltage protection, overvoltage protection only or no protection at all for the new  main distribution board, before

you add an infeed . Depending on this choice, the selection of a surge arrester type w ill then be available in the insert w izard for loads that

are to be added later, or it w ill not be available.

- No protection à no arrester type can be selected

- Overvoltage protection only à arrester type can be selected

- Lightning and overvoltage protection à arrester type can be selected

When “Lightning and overvoltage protection“ has been selected, transitions betw een buildings can also be considered in your planning. For

this purpose, the insert w izard of the relevant items offers a “building transition“ for selection, or this building transition can later be selected

and deselected in the properties of the respective connection (if  selected in the graphic) w hich are show n at the bottom left of the screen.

For an overview  of the "pow er sources" in netw ork calculation, i.e. transformers, generators, and UPS, please refer to the corresponding

chapter of the Technical Manual for the SIMARIS planning tools, w hich you can access using the Help menu  à "Technical Manual".

The variants available as infeeds are presented in the follow ing.

31
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Transformer with medium voltage

n This icon can be used to add an infeed circuit w ith transformer, medium

voltage sw itching/protective device and transformer feeder line as w ell as

the low -voltage side supply of the main distribution board via cables or

busbars. 

Information about the "Typif ication of circuit-breakers in medium-voltage

sw itchgear" can be found in the corresponding chapter of the "Technical

Manual for the SIMARIS planning tools, w hich you can access using the Help

menu  à "Technical Manual".

n Before adding an infeed you have to define w hether you w ant to configure

lightning current and overvoltage protection, overvoltage protection only or

no protection at all for the new  main distribution board.  

n Attention: If  "Transformer w ith medium voltage" is selected as infeed, w hen

isolated netw orks are designed, these isolated netw orks are only separated

at the low -voltage side. The medium voltage side is regarded as one

netw ork.

Transformer without medium voltage

n This icon can be used to add an infeed circuit w ith transformer w ithout a

medium-voltage section and low -voltage-side supply of the main distribution

board via cables or busbars. 

n If  you have enabled the query for checking ligthning current and overvoltage

protection,you must define prior to adding the new  main distribution board,

w hether you w ant to configure ligthning current plus overvoltage protection,

overvoltage protection only or no protection for the new  distribution board. 

31
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Generator

n This icon can be used to add an infeed circuit w ith

transformer, medium voltage sw itching/protective device and

transformer feeder line as w ell as the low -voltage side supply

of the main distribution board via cables or busbars. 

n If  you have enabled the query for checking ligthning current and

overvoltage protection,you must define prior to adding the new

main distribution board, w hether you w ant to configure ligthning

current plus overvoltage protection, overvoltage protection only

or no protection for the new  distribution board. 

Neutral netw ork infeed

n This icon can be used to add an infeed circuit w ith transformer

w ithout a medium-voltage section and low -voltage-side supply

of the main distribution board via cables or busbars. 

n If  you have enabled the query for checking ligthning current and

overvoltage protection,you must define prior to adding the new

main distribution board, w hether you w ant to configure ligthning

current plus overvoltage protection, overvoltage protection only

or no protection for the new  distribution board. 
n In the f irst w indow  of the insert w izard the netw ork infeed has

to be defined by entering impedances, loop impedances or

short-circuit currents.

When clicking the "Next" button, the second w indow  of the insert

w izard opens, the layout of w hich differs depending on the

selected type of netw ork infeed: 



52

n Impedances (second w indow  of the insert w izard) 

Formula symbols used in the insert w izard:

Z1 = impedance of the positive phase-sequence system

Zs = loop impedance

R1 = resistance in the positive phase-sequence system

Rs = loop resistance

X1 = reactance in the positive phase-sequence system

Xs = loop reactance

n Loop impedances (second w indow  of the insert w izard) 

Formula symbols used in the insert w izard:

Zs = loop impedance

φ = phase angle

R0 = resistance in the zero phase-sequence system

R1 = resistance in the positive phase-sequence system

X0 = reactance in the zero phase-sequence system

X1 = reactance in the positive phase-sequence system
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n Short-circuit currents (second w indow  of the insert

w izard) 

Formula symbols used in the insert w izard:

Ik3 = three-pole short-circuit current

Ik1 = single-pole short-circuit current

φ3 = phase angle of the three-pole short-circuit current

φ1 = phase angle of the single-pole short-circuit current

Note: Input of phase angle is only possible w ith the

professional version of SIMARIS design and an activated

extended value range (see section Properties and equipment

dialogue of neutral netw ork infeeds ). 

n In the third w indow  of the insert w izard, the further

required basic settings for the neutral netw ork infeed to

be defined can be made now . The third w indow  looks the

same for all 3 variants of the neutral netw ork infeed. 

It is possible to create any number of infeeds of the same type (transformer, transformer w ith medium voltage, generator

or neutral network infeed) as parallel infeeds.

After having placed the f irst infeed, the icon of the desired pow er source must still be activated in the

library. 

Move the mouse pointer along the low -voltage main distribution until a yellow  insert symbol is displayed.

Press and hold the left mouse button and move the mouse upw ards / to the front until a new  branch line

is displayed. As soon as the left mouse button is released, the insert w izard appears again.
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Repeat this procedure to add more pow er sources.

Result: 

Representation of a parallel infeed w ith pow er sources of similar type.

5.2.2.1.2  Couplings

Pow er sources can be connected w ith each other via couplings.

After having inserted a coupling in the netw ork diagram, the respective insert w izard opens, in w hich basic settings can be made. Please note

the follow ing for the data selection:

n The data items available for selection are each provided in drop-dow n menus. 
n For lengths of connecting lines (cable/w ire or busbar), input values from 0.1 to 10,000 m are permissible.

n It is necessary to select a sw itching device upstream and dow nstream of the connecting line.

Coupling

This icon can be used to create tw o different types of couplings:

n a general coupling w ith an undefined direction of energy f low  to

map a normal pow er supply netw ork; 
n a directed (unidirectional) coupling w ith a defined direction of

energy f low  to map an emergency pow er supply netw ork.

  

  

Which coupling is  inserted depends  on  your  decision  at  w hich  of

the 4 available insert  points  of  a  low -voltage  main  distribution  the

coupling is inserted. 

n At the tw o inner insert points of the busbar, directed couplings

are created. 
n At the tw o outer insert points of the busbar, general couplings

are created

More information about "directed and non-directed couplings" in

SIMARIS design can be found in the appropriate section of the

Technical Manual for the SIMARIS softw are tools, w hich you can

access using the Help menu  à "Technical manual".31
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Creating  a  directed  coupling  (use  the  inner  insert  points  on  the

busbar)

n After having successfully created an infeed (transformer w ith or

w ithout medium voltage, generator or neutral netw ork infeed),

select the "Coupling" icon in the library and move the mouse

pointer in the graphics w indow  to one of the inner insert

positions. Keeping the left mouse button pressed, move the

mouse dow nw ards / to the rear or upw ards / to the front until an

new  branch line is displayed and then release the mouse button. 

Note:

Typical application: directed coupling acc. to VDE 0100 Part 710

(hospital, normal supply / safety supply netw ork)

This coupling does not permit parallel netw ork operation and energy

feedback to the pow er supply system of the netw ork operator!

More information about how  to create active can be found in the

appropriate section of the Technical Manual for the SIMARIS

softw are tools.

 

  

In the f irst w indow  of the insert w izard for the directed coupling,

the direction of energy f low  of the unidirectional coupling is defined,

i.e. either the new  main distribution or the already existing main

distribution can be selected as emergency pow er supply system.

In the second w indow , the basic settings for the coupling have to

be made. 
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The third w indow  of the insert w izard is used for selecting the type

of infeed for the new  main distribution. 

All types of infeed are provided for selection, i.e. transformer w ith

or w ithout medium voltage, generator and neutral netw ork infeed.

The fourth w indow  of the insert w izard corresponds to the insert

w izard of the respective selected infeed.

Connecting separate netw orks

As a licence holder of the professional version of the program you

have the option to subsequently connect separate netw orks to a

directed coupling. Directed couplings can be inserted betw een

distribution boards at the same as w ell as at different levels.
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The insertion of the f irst directed coupling and the definition of the

normal and emergency pow er system predetermines the direction

of energy f low  of all further couplings accordingly.

Any number of outgoing coupling feeders may be created per

output distribution board, but only one coupling infeed is permitted

per target distribution board.

 

Creating a general coupling (use the outer insert points on the busbar)

n Normal (ie. "general") couplings can only be created in a main distribution system. 
n A subsequent connection of 2 separate netw orks by means of a general coupling is currently not

possible.

n After having successfully created an infeed (transformer w ith or w ithout medium voltage, generator

or neutral netw ork infeed), select the "Coupling" icon in the library and move the mouse pointer in

the graphics w indow  to one of the outer insert positions. Keeping the left mouse button pressed,

move the mouse dow nw ards / to the rear, upw ards / to the front or to the left/right, until an new

branch line is displayed and then release the mouse button.

Notes:

The general coupling is a busbar coupling w hich allow s for parallel netw ork operation and, if  generators

are used, for energy feedback to the pow er supply system of the netw ork operator.

In the f irst w indow  of the insert w izard, the direction of energy f low

of the general coupling is displayed.
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In the second w indow , the basic settings for the coupling have to be

made. 

In the third w indow , the type of infeed for the new  main distribution is

defined. 

All types of infeed are provided for selection, i.e. transformer w ith or

w ithout medium voltage, generator and neutral netw ork infeed.

The fourth w indow  of the insert w izard corresponds to the insert

w izard of the respective selected infeed.
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5.2.2.2  Adding distribution boards
The basic version provides f ive, the professional version six different types of distribution boards for selection in the library:

n Sub-distribution board 
n Group sw itch

n Busbar trunking system

n Busbar trunking system w ith centre infeed

n Distribution board at the end of a busbar trunking system / rising mains cable

n Distribution board w ith equivalent electric circuit (impedance)

In general, distribution boards can be inserted in the netw ork diagram by selecting the icon of the required distribution board in the library,

searching for a suitable insert point (yellow  rectangle) by moving the mouse pointer in the netw ork diagram along the low -voltage main distribution

and inserting the distribution board by pressing and holding the left mouse button, dragging the mouse pointer aw ay from the insert point and

finally releasing the mouse button at the selected insert point.

After having added a distribution board to the netw ork diagram, its insert w izard opens in w hich basic settings can be made. Please note the

follow ing for the data selection:

n The data items available for selection are each provided in drop-dow n menus. 
n For lengths of connecting lines (cable/w ire or busbar) or the busbar trunking system itself, input values from 0.1 to 10,000 m are

permissible.

Sub-distribution board

n This icon can be used to add a sub-distribution board in the form of a

distribution cabinet to a main or sub-distribution. 
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Group sw itch

n This icon can be used to create a group sw itch or group back-up fuse

w ithin a distribution cabinet or rising mains cable.  

n Special use of the group sw itch in equivalent circuit mapping for a main

distribution system w ith many pow er consumers:  
Soll eine Hauptverteilung mit vielen Verbrauchern dargestellt w erden, so

kann als Ersatzdarstellung die Haupsammelschiene mit einem

Gruppenschalter verw endet w erden. In diesem Fall muss beim Einfügen

des Gruppenschalters im Feld "Art des Schaltgerätes" die Ausw ahl

"keines" getroffen w erden. Anschließend w erden die Verbraucher im

Netzplan grafisch an der Sammelschiene des Gruppenschalters platziert.  

Busbar trunking system

n This icon can be used to insert a sub-distribution board in the form of a

busbar system w ith infeed from one end. 

Particularity of busbar trunking systems: 

Except for group sw itches and motor starter combinations, all types of

distribution boards and pow er consumers can be directly connected to

busbar trunking systems.

Exception: 

If  the busbar trunking system is intended as a rising mains cable for building

floor supply (f irst type of connection: direct connection, second type of

connection: cable/w ire), this enables a group sw itch to be connected directly

to the busbar trunking system.

A system overview  of the various busbar systems incl. their technical data

and configuration rules can be found in the "Busbar trunking systems" section

of the Technical Manual for SIMARIS softw are tools w hich you can access

using the Help menu  à "Technical manual".31
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General information on busbar trunking systems: 

At the end of each busbar line there is a so-called "gripper". It is used to

graphically extend the busbar.

To extend a busbar, place the mouse pointer on the "gripper", press and hold

the left mouse button and drag it in the direction of the desired busbar

extension. This is a purely graphical extension and has nothing to do w ith the

real length of the busbar.

Moreover, it is possible to add another busbar line at the "gripper", w ith

different properties than the main busbar line. To do this, the “Busbar

trunking system“ icon in the library must be activated and the mouse pointer

must be placed on the “gripper”. Now , a yellow  triangle is displayed above

and below  the "gripper". By pressing and holding the left mouse button and

moving the mouse pointer at a right angle to the existing busbar trunking

system, a new  busbar line can be created. As soon as the new  line is

displayed, it is possible to align it vertically as w ell as horizontally to the

existing busbar line.

The properties of the new  busbar line can be changed in the equipment

dialogue (to be called via the menu provided via the right mouse button à
Properties, w hen the mouse pointer is positioned on the item of equipment)

independent of the main busbar line. 

Adding further loads or distribution boards to the busbar line:

In general, further distribution boards or also loads can be connected to the

busbar line by selecting the corresponding icon in the library, searching for a

suitable insert point (yellow  rectangle) and inserting the distribution board or

pow er consumer at this point by pressing and holding the left mouse button

and then dragging the mouse pointer at a right angle to the busbar.

After a load or distribution board w as insterted at a busbar trunking system,

the position of the branch line / connection at the busbar system has to be

defined.

In the f irst w indow  of the insert w izard, the distance of the respective insert

point to the starting point of the busbar system has to be defined, and the

total length of the busbar system can be adjusted, if  necessary.

This w indow  for placing the outgoing feeders can be called up at a later time

during configuration by right-clicking on the busbar and selecting the sub-

menu item "Lengths ...". After several loads or distribution boards have been

added, this w indow  can also be used for providing an automatic, even

distribution of the items of equipment w ith settable distances.

The second w indow  of the insert w izard corresponds to the respective

insert w izard of the selected load or distribution board.
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Busbar trunking system w ith centre infeed

n This icon can be used to insert a sub-distribution board in the form of a

busbar system w ith centre infeed. 

In this case, not only the length of the busbar system starting from the

connection point has to be entered in the insert w izard but also the length of

the tw o branch lines starting from the branching point.

The insertion of distribution boards and loads at these busbars w orks in the

same w ay as described above.

A system overview  of the various busbar systems incl. their technical data

and configuration rules can be found in the "Busbar Trunking Systems"

section of the Technical Manual for SIMARIS softw are tools w hich you can

access follow ing the link for the Help menu  à "Technical manual".

Distribution board at the end of a busbar trunking system /

rising mains cable

n This icon can be used to insert a sub-distribution system at the end of a

busbar trunking system or of a rising mains cable, that means at a

"gripper". 

The insert w izard displayed on the left only asks for the definition of the type

of system configuration and the type of sw itchgear.

The insertion of distribution boards and loads at this sub-distribution w orks in

the same w ay as described above.

31
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Distribution w ith equivalent electric circuit (impedance)

n This icon can be used to insert an equivalent electric circuit (impedance) in

the netw ork diagram. How ever, this is only possible in the professional

version, i.e. if  the professional mode is not active, this icon is not

displayed. 
n This equivalent impedance can be used as an aid to simulate connecting

lines (cables/w ires - e.g. acc. to AWG; busbars for pow er transmission),

reactor coils, isolating transformers, etc. It can also be used for mapping

existing connecting lines on w hich an impedance measurement has been

performed.

In the insert w izard, the zero or positive phase-sequence system of the

phase, N and PE(N) conductors are to be entered: For the entry of

resistances and reactances, values in the range from 0.1 to 10,000 mΩ are

permissible.

"Impedances voltage drop relevant"

If  this option is enabled (checkmark set), the calculated voltage drop across

the equivalent electric circuit (impedance) w ill be displayed and considered in

the overall calculation, otherw ise the value w ill not be included in the

calculation and w ill not be displayed.

Formula symbols used in the insert w izard:

R0 = resistance in the zero phase-sequence system

R1 = resistance in the positive phase-sequence system

X0 = reactance in the zero phase-sequence system

X1 = reactance in the positive phase-sequence system

Z0 = impedance of the zero phase-sequence system

Z1 = impedance of the positive phase-sequence system
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5.2.2.3  Adding final circuits
The library provides six different types of f inal circuits for selection: 

n Stationary load 
n Pow er outlet circuit

n Motor

n Frequency converter

n Charging unit

n Capacitor

n Dummy load

n Overvoltage protection

In general, f inal circuits can be added to the netw ork diagram by selecting the icon of the required f inal circuit in the library, searching for a

suitable insert point (yellow  rectangle) by moving the mouse pointer in the netw ork diagram along the low -voltage main or sub-distribution and

inserting the f inal circuit by pressing and holding the left mouse button, dragging the mouse pointer aw ay from the insert point and f inally releasing

the mouse button at the selected insert point.

When a distribution board w as added to the netw ork diagram, its insert w izard opens in w hich basic settings can be made. Please note the

follow ing for the data selection:

n The data items available for selection are each provided in drop-dow n menus. 
n For lengths of connecting lines (cable/w ire or busbar) or the busbar trunking system itself, input values from 0.1 to 10,000 m are

permissible.

n The info buttons next to the "System configuration" and "Busbar system" f ields provide further information about these issues, w hich is

then displayed in another w indow . 

n Depending on the choices made for lightning and overvoltage protection w hen adding the infeed, the selection of a surge arrester type w ill

then be available in the insert w izard for loads to be added, or it w ill not be available.

- No protection à no arrester type can be selected

- Overvoltage protection only à arrester type can be selected

- Lightning and overvoltage protection à arrester type can be selected
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Stationary load

n This icon allow s a stationary load or load group (several identical pow er

consumers) to be connected to a main or sub-distribution system. 

Ow ing to the correlation of nominal current and active pow er, any

modif ication of the selection of one of these f ields automatically leads to a

corresponding adaptation of the value of the other f ield.

The number of loads in a load group can be defined in the "Quantity" f ield.

Pow er outlet circuit

n This icon allow s a non-stationary load or load group (several identical

pow er consumers) to be connected to a main or sub-distribution. 

Because of the interrelation betw een nominal current and active pow er,

any modif ication of the selection of one of these f ields automatically leads to

a corresponding adaptation of the value of the other f ield.

Via the "Quantity" f ield you can define the number of loads in a load group.
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Motor

n This icon allow s a motor or motor group (several identical

motors) to be connected to a main or sub-distribution. 

The functionality of the motor feeder has been considerably

expanded compared to SIMARIS design version 5.0. Besides

simple standard motor protection, starter combinations can now

also be selected and dimensioned, for example a direct-on-line

starter, a starter for reversing mode, a star-delta starter or a soft

starter. 

The number of motors in a motor group can be defined in the

"Quantity" f ield. 

If  "Simple motor protection" or "Frequency converter" is selected

as motor type, the insert w izard can be closed by clicking on

"Finish".

If "Motor starter combination" is selected as motor type, clicking

the "Finish" button takes you to the second w indow  of the insert

w izard, in w hich the further settings required in this case can be

made or data be displayed.

Note: A second circuit-breaker is dimensioned for motor starter

combinations in direct-on-line start or reversing mode, having a

nominal voltage of 690 V and a mechanical pow er greater than

0.75 kW. This 3RV circuit-breaker featuring only one I-release

implements a limiting function to ensure coordination type 2.

The info button linked to the "Type of co-ordination" f ield makes

further information about this subject available and displaysit in

another w indow . 
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Frequency converter

n With this icon you can add a frequency converter to the main

or sub distribution. 

n The type of frequency converter w ill be determined

automatically on basis of the performance and the application.
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n If  "Frequency converter" is selected, in the section "Installation

type" you can choose betw een

 - Built-in unit

 - Cabinet

The lengths of the shielded cable betw een frequency converter

and motor can be determined.

As cable cross-section the maximum connectable one is selected

by default.
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Charging unit

n This icon can be used to connect the charging unit to a main or

sub-distribution system. 

Using the info buttons next to the f ields "Integrated protection" and

"Type of charging unit", you can call up further information about

the charging units.

 

Capacitor

n This icon allow s a reactive pow er compensation unit to be

connected to a main or sub-distribution. 
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Dummy load

n This icon can be used to define dummy loads and insert them in

the netw ork diagram. They are used as a substitute model to

map e.g. existing (sub-)netw orks, thus influencing the energy

balance. In this circuit, no sw itchgear or cables/w ires are

dimensioned. 

Because of the interrelation betw een nominal current and active

pow er, any modif ication of the selection of one of these f ields

automatically leads to a corresponding adaptation of the value of

the other f ield.

Overvoltage protection

n This icon can be used to insert surge arresters in the netw ork

diagram. 
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5.2.2.4  Graphical editing of elements

The "selection tool" can

n either be enabled on the tool bar or  
n by disabling the icon selected in the library again, because in this case the selection tool is

enabled automatically.

Besides using the edit options kept in the menu bar  and the tool bars in the Main w indow

or Netw ork design  you can also edit the elements using the context menu: place the

mouse pointer on the element to be edited, and press the right mouse button.

Using the context menu, it is possible to 

n rotate complete parts of the netw ork diagram, i.e. system infeed, distribution boards and

final circuits, counter-clockwise or clockwise, that is to set a different arrangement or

alignment of the elements. 
n to Copy, Cut and Paste complete elements of the netw ork diagram, i.e. system infeeds,

distribution boards and f inal circuits. To do so, f irst select the corresponding element and

then copy, cut or paste it via the context menu. After having cut or copied, you can call the

context menu again at any other position in the netw ork diagram via the right mouse button,

select Paste so that the element is selected for being placed (graphic "is hanging" at the

mouse pointer) and then insert the element in the netw ork diagram at the desired position by

left-clicking at a suitable point (yellow  rectangle).

n copy sub-elements of system infeeds, distribution boards and loads such as cables or

certain sw itching devices, by selecting the sub-element and then selecting "Copy

element" from the context menu. Subsequently, the sub-element can be inserted at any

position in the netw ork diagram again by selecting "Paste" from the context menu at any

position in the netw ork diagram and then inserting the sub-element by left-clicking at the

desired position in the netw ork diagram. The inserted element is additionally marked by a

padlock symbol, i.e. it w ill not considered for automatic dimensioning.

n delete selected elements by selecting "Remove load" or "Remove sub-distribution

board" or "Remove main distribution board", w hich are show n in the context menu

depending on the type of element selected in the netw ork diagram.

n to Add a favourite. After an element and "Add favourite..." w as selected, a w indow  for

entering a name and comment is opened. Favourites are automatically assigned to the group

of system infeeds, distribution boards or loads. Favourites can later be included at other

positions in the project or also in different projects (use the Favourites library).

n call up the Properties of the respective selected element (the equipment dialogue), i.e.

have expanded properties (compared to the properties displayed to the left of the graphics

w indow ) displayed in an opening w indow . To some extent, the displayed equipment data

can also be changed / set in this w indow .

Moving distributions w ithin the graphic:

After having left-clicked a main or sub-distribution system, this distribution system is displayed

in yellow  w ith a blue frame and the mouse pointer turns into a drag icon. By keeping the left

mouse button pressed, the distribution can now  be moved as desired. Moving a selected

distribution system is also possible directly in small steps using the arrow  keys or, via the key

combination Shift + arrow  keys in larger steps.

If tw o distributions are moved in such a w ay that they overlap each other graphically, this

overlap is marked by a red-dotted line in order to point out that no electrical connection exists

here.

19
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Moving and copying circuits w ithin the graphic:

When left-clicking a sub-element of a circuit instead of a distribution, this sub-element is

highlighted in grey and the complete circuit is framed in blue.

n This circuit can now  be moved by keeping the left mouse button pressed, i.e. by cutting it

from this point in the netw ork diagram and pasting it again at a different appropriate point. 
n By simultaneously pressing the left mouse button and the "Ctrl" key, the circuit can be

copied, i.e. it remains there and can nevertheless be inserted additionally at another

appropriate point.

Further options to edit the graphic, e.g. for alignment, can be found in the tool bar in Netw ork

design and also in the program menu. These functionalities are described in detail in the section 

Netw ork design . Some of them can also be called via the key combinations described in the

section Menu bar and key combinations . 

10
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5.3  Properties of circuits and equipment

Introduction to the properties and equipment dialogues

Each circuit in the netw ork diagram, i.e. each system infeed, distribution and f inal circuit, is composed of several sub-elements. For each of these

circuits as w ell as for each sub-element, the properties can be displayed w hen the corresponding selection has been made in the graphic:

n In the left part of the screen, below  the Library and Hints section, the properties of the selected circuit are displayed and can in parts also

be adapted there. 
n When selecting a sub-element, its main properties are displayed below  the circuit properties, and can in parts also be adapted there.

n By double-clicking a sub-element w ith the left mouse button or by calling the context menu via the right mouse button (à Properties), it is

moreover possible to open a new  w indow  w ith the equipment dialogue for the sub-element, displaying the detailed properties of this sub-

element. In this dialogue, various settings can be made. These changes can be applied to all similar new  elements by clicking the "As

default" button. Defaults defined this w ay are saved beyond the program runtime and w ill therefore also be valid after a restart.

The equipment dialogues of the infeed and distribution equipment as w ell as of the overvoltage protection equipment each also provide the option

to enable or disable automatic dimensioning of the selected equipment.

By setting or removing the checkmark in this f ield, the selected sub-element can either be included in automatic dimensioning by the program or

excluded from it. If  the checkmark is removed, i.e. the element is excluded from automatic dimensioning, this is indicated in the equipment dialogue

and in the netw ork diagram by a padlock symbol  displayed next to the sub-element. How ever, this also means that for this element the

properties set by the user w ill also remain if  automatic dimensioning of the netw ork is carried out.

In the follow ing, the equipment dialogues and properties of the different operating elements w ill be described, show ing the data w hich can be set

in the respective dialogues.

5.3.1  Properties of circuits

Properties of circuits for infeed and distribution:

It is possible to change or select the

n designation 
n system configuration

n simultaneity factor

n separate protection (only for feed-in circuits)

n target of dimensioning

n selectivity interval, if  applicable.

The designation assigned automatically and consecutively w hen the circuit is created (consecutive number and letter combination) can be

changed as required.

In a selected infeed circuit, all 4 variants of the system configuration are provided for selection, i.e. it can be set w hether the infeed circuit is

to be created as TN-C, TN-S, IT or TT netw ork. If  there are several parallel infeeds, the system configuration selected for one of the infeed

circuits w ill automatically be applied to all other existing and further added parallel infeeds.

For basic information about the different pow er system configurations, please refer to the section "Pow er Supply Systems, Connection to Earth"

in the Technical Manual for the SIMARIS softw are tools, w hich you can access using the Help menu  à "Technical manual".31
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Depending on the selection in the infeed circuit, the system configuration options for distribution boards and f inal circuits w ill be restricted:

n Infeed circuit TN-S, IT or TT à distribution boards w ill show  the same system configuration as the infeed, w hich cannot be changed. 
n Infeed circuit TN-C à TN-S or TN-C are possible as system configuration.

The info button linked to the "System configuration" f ield makes further information about this subject available, w hich is displayed in the next

w indow .

The simultaneity factor is the ratio of maximum pow er required compared to installed capacity. It takes into account that often not all of the

pow er consumers in a plant are operated simultaneously, and in case of simultaneous operation they are not alw ays operated under full load.

The value range of this factor is to be set betw een 1 (= alw ays full load, i.e. 100 %) and 0 (= alw ays sw itched off). If  the simultaneity factor is

set to 0, the item of equipment w ill not be considered in automatic dimensioning and w ill therefore remain undimensioned.

In feed-in circuits of type 'neutral system infeed', or transformer or generator circuits, there is the option to protect parallel cables

separately.These cables can either be determined by dimensioning or selected manually. A detailed description of how  to create such protection

and select it can be found in the section "Circuit properties for infeed circuits w ith separate protection of parallel cables".

As target of dimensioningBackup protection or Selectivity can be selected.

Backup protection means that the sw itching and protective devices that w ere automatically selected by SIMARIS design w ill protect themselves

or w ill be protected by an upstream-connected sw itching device in case of a possible short circuit.

Selectivity means that current grading of the sw itching devices w ill be performed betw een the circuits during automatic dimensioning, current

grading being applied from circuit to circuit. Selecting this setting does not necessarily result in a selective behaviour of the determined protective

assemblies, since the behaviour of device combinations regarding selectivity can only be established by testing. In the professional version you

can display information regarding the selectivity of the protective assemblies that w ere determined (see section View  menu  and section

Selectivity ).

Clicking the info button opens a new  w indow  that contains further information on backup protection and selectivity.

The Selectivity interval can only be set if  "Selectivity" has been set as the Target of dimensioning. From version 6.0 on, the default value is 1.0.

Nevertheless, the user can set values betw een 1 and 3. It might be necessary to adapt this setting corresponding to the device combinations

used and the short-circuit currents present in the configured netw ork in order to allow  for dimensioning. It might, for example, happen that w hen

using fuse technology in combination w ith a large selectivity interval and low  minimum short-circuit currents that suitable fuses cannot be

determined to attain selective device tripping.

The "As default" button refers to the target of dimensioning and the selectivity interval. After a new  project has been created, all the equipment

added to the netw ork diagram is f irst created w ith the target of dimensioning "Backup protection". Though, if  a circuit is selected and its target of

dimensioning is set to "Selectivity" and the selectivity interval to 2, for example, and if the "As default" button is then pressed, all further equipment

new ly inserted in the netw ork diagram w ill be created w ith these parameters. How ever, the equipment inserted before w ill keep its previous

settings.

This can be changed by clicking the "Apply" button w hich also refers to the target of dimensioning and the selectivity interval, because this

effects that the new  settings made for an element w ill be applied to the entire netw ork up to a possibly existing coupling.

More information about "Selectivity and Backup protection" can be found in the corresponding section in the Tedhnical Manual for the SIMARIS

softw are tools, w hich you can access using the Help menu  à "Technical manual".

Circuit properties for infeed circuits w ith separate protection of parallel cables

If  you intend to equip the feed-in system using a netural system infeed, a transformer or

generator w ith parallel cables and protect these cables separately, w e recommend to do so

immediately w hen creating the feed-in system by selecting the necessary sw itching devices,

w hich are usually fuses, as 'Type of sw itchgear'.

Depending on w hether you w ant to protect equipment separately at the beginning and end of

a cable route, or merely at ist beginning, you must select this cable route at the beginning plue

end or only at the beginning.

With couplings you cannot create separate protection of parallel cable routes. 
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Splitting a cable route into several parallel cables may result from the dimensioning cycle of

the netw ork diagram or be set manually.

It is show n in the equipment dialogue in the "Number of cables" f ield and can also be set

there.

In this context it is also possible to select the number of cables per device, w here the number

of cables must be a multiple of the number of cables per device.

Corresponding to the settings made at this point, protective devices are assigned to the

cables. This means dependent on the number of cables determined or set and the number of

cables per device, the number of protective devices required is established and assigned to

the cables.

This equipment dialogue can either be called up by double-clicking the cable route or by

selecting the cable route and choosing à"Properties" from the context menu (right mouse

button).

For more explanations about this equipment dialogue, please refer to Properties and

equipment dialogue of low -voltage cables / w ires .

As soon as you have selected the cable route of the feed-in system on the netw ork diagram,

you can select seperate protection of parallel cables at the bottom left in the circuit

properties.

You can choose betw een seperate protection at the beginning of the cable route only, or at

the beginning and end of the cable route.

In analogy to the selection of separate protection made, the netw ork diagram is displayed as

follow s.

The number of parallel cables can be selected in the equipment dialogue of the cable route,

see description above.

The number of sw itching devices is adapted to the number of cables accordingly, depneding

on your selection.

Attention: it is not possible to adapt separate protection by changing the number of sw itching

devices, you must alw ays do so by changing the number of parallel cables.

n If  "upper and low er" w as selected, the sw itch labelling of the netw ork diagram at the

beginning and end of the cable route w ill be automatically matched to the number of

parallel cables.  

85
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n If  "upper" w as selected, the sw itch labelling of the netw ork diagram at the beginning of

the cable route w ill be automatically matched to the number of parallel cables.  

n If  "w ithout" w as selected, the labelling of the netw ork diagram upstream and dow nstream

of the cable route w ith parallel cables w ill be automatically matched to one sw itching

device.   
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Clicking the info button next to the "Separate protection" f ield, you can call up an information w indow , w here

n schematic circuit diagrams are show n depicting the various options and  
n a description is given as to w hich preconditions and assumptions make such a separate protection of parallel cables a reasonable and

feasible solution.

Basic information about the topic "Considering parallel cables in netw ork calculations" can be found in the Technical Manual, w hich you can

access using the Help menu  à "Technical manual".31
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Properties of load circuits:

It is possible to change the

n system configuration, if  applicable (in the case of a TN-C netw ork in the infeed

circuit, see above) 
n capacity factor 

n quantity

n standard for MCB selection

n target of dimensioning

n selectivity interval, if  applicable.

Information on the selection of the system configuration and target of dimensioning as w ell as on the possibly required setting of the

selectivity interval can be found in the second last section (Circuit properties for infeed circuits and distribution circuits). 

In the properties of the load circuit, the capacity factor is displayed instead of the simultaneity factor (w hich is used for infeed and distribution).

By default, it is set to 1, but it can be set to values betw een 0 and 1. This factor defines the load under w hich the pow er consumers are generally

operated (mostly no full load). The load current to considered in the upstream distribution w ill be reduced correspondingly. 

Using the "Quantity" field the selected circuit can be duplicated any number of times and thus be factored into calculations accordingly. The

multiplication is indicated by labelling the load w ith "3x", for example, in the netw ork diagram. How ever, this multiplication of load circuits is 

notpossible if  these load circuits are connected to a busbar system, since such an installation is not possible ow ing to the lack of connection

options for the tap-off units that w ould be required for such a solution.

Depending on the fact w hether these electrical installations are accessible for ordinary persons or not, the selection of miniature circuit-breakers

(MCBs) must follow  different standards,

n for installations accessible by ordinary persons, IEC 60898, 
n for installations inaccessible by ordinary persons, IEC 60947-2 is applicable.

You can make this selection in the load circuit properties depending on project requirements.

More information about this topic can be found in the section "Dimensioning the pow er system acc. to Icu or Icn" in the Technical Manual for the

SIMARIS softw are tools, w hich you can access using the Help menu  à "Technical manual".

 

31
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5.3.2  Properties and equipment dialogue of medium-voltage switching
devices

Properties of a medium-voltage switching device

It is possible to change the 

n designation of the sw itch 
n sw itch type. 

Equipment dialogue of a medium-voltage switching device

It is possible to change or define the

n designation 
n primary rated current of the current transformers (if  Circuit-breaker has

been selected as Sw itch type).

Moreover, the device established through automatic dimensioning can be

replaced w ith a different device by selecting it in the catalogue.

n Regarding medium-voltage circuit breakers you can select either DMT

(definite-time overcurrent protection) oer IDMT (inverse-time overcurrent

protection) in the w indow  "selectivity".

n For IDMT you can select the follow ing characteristics:

- IEC inverse

- IEC very inverse

- IEC extreme inverse

- IEC long time inverse
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5.3.3  Properties and equipment dialogue of medium-voltage cables / wires

Properties of a medium-voltage connection

It is possible to change the

n designation of the cable 
n length.

Equipment dialogue of a medium-voltage connection

It is possible to change or define the

n designation 
n cable building type

n type of cable

n cross-section conductor

n conductor arrangement

n Installation type

n reduction factor f tot

n length.
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5.3.4  Properties and equipment dialogue of transformers

Properties of a transformer

It is possible to change the 

n designation 
n rated pow er

n rated short-circuit voltage.

Equipment dialogue of a transformer

It is possible to change the

n designation 
n manufacturer

n product / type

n vector group

n fan mounted

n rated pow er Sn

n rated short-circuit voltage ukr

n short-circuit losses Pk

n no-load loss P0.

By setting the "Manufacturer" f ield to "Any entry", the stored value selection

for Siemens transformers is disabled. This means that it is now  possible to

enter user-specif ic transformer data. The tooltip displays possible value

ranges. But this also means that this transformer is excluded from

automatic dimensioning, i.e. the checkmark at "Automatic dimensioning" is

removed or replaced by the padlock symbol  next to it. This padlock

symbol w ill then also be displayed on the netw ork diagram so that it also

becomes clear in the overview  that this element w ill not be included in

automatic dimensioning.
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5.3.5  Properties and equipment dialogue of generators

Properties of a generator

It is possible to change the

n designation 
n apparent pow er Sn.

Equipment dialogue of a generator

It is possible to change or set the

n designation 
n manufacturer

n apparent pow er Sn.

If "Siemens" has been selected as manufacturer, all further properties are

only displayed and cannot be changed (input f ields are grey), because these

are standard values referring to Siemens products:

n pow er factor cos(j) 
n subtransient reactance xd"

n resistance in the positive phase-sequence system r1

n single-pole continuous short-circuit current Ik1D

n three-pole continuous short-circuit current Ik3D.

By setting the "Manufacturer" f ield to "Any entry", the stored value selection

is disabled. This means that it is now  possible to enter user-specif ic

generator data. The tooltip displays possible value ranges. But this also

means that this generator is excluded from automatic dimensioning, i.e. the

checkmark at "Automatic dimensioning" is removed or replaced by the

padlock symbol  next to it. This padlock symbol w ill then also be

displayed on the netw ork diagram so that it also becomes clear in the

overview  that this element w ill not be included in automatic dimensioning.
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5.3.6  Properties and equipment dialogue of neutral network infeeds

Properties of a neutral network infeed

It is possible to change the

n designation 
n rated current

Equipment dialogue of a neutral network infeed

Depending on how  the neutral netw ork infeed has been defined, via

impedances, loop impedances or short-circuit currents, the

corresponding data is displayed in the equipment dialogue w indow .

When defining a neutral netw ork infeed via impedances, it is possible

to set the

n designation 
n In = nominal current

n maximum positive phase-sequence impedance Z1max

n minimum positive phase-sequence impedance Z1min

n maximum loop impedance Zsmax

n minimum loop impedance Zsmin

n ratio of maximum resistance in the positive phase-sequence

system to maximum reactance in the positive phase-sequence

system (R1 max / X1 max)

n ratio of minimum resistance in the positive phase-sequence system

to minimum reactance in the positive phase-sequence system (R1

min / X1 min)

n ratio of maximum loop impedance to maximum loop reactance (Rs

max / Xs max)

n ratio of minimum loop impedance to minimum loop reactance (Rs

min / Xs min).

The values to be entered can be determined by separate calculations

or obtained from the pow er supply netw ork operator.

When defining a neutral netw ork infeed via loop impedances, it is

possible to set the

n designation 
n In = nominal current

n Zs = loop impedance

n j = phase angle

n R0 / R1 = ratio of resistance in the zero phase-sequence system

to resistance in the positive phase-sequence system

n X0 / X1 = ratio of reactance in the zero phase-sequence system to

reactance in the positive phase-sequence system 

n Ikmax / Ikmin = ratio of maximum to minimum short-circuit current.

The values to be entered must be determined by measurement.
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When defining a neutral netw ork infeed via short-circuit currents, it is

possible to set the

n designation 
n In = nominal current

n Ik3max = maximum three-pole short-circuit current

n Ik3min = minimum three-pole short-circuit current 

n Ik1max = maximum single-pole short-circuit current 

n Ik1min = minimum single-pole short-circuit current.

For the values to be entered please consult your pow er supply

netw ork operator and ask them about local conditions.

If values are not available, you can expect Ikmin/max = 10 kA for a

service entrance w ith 250 A supply (= value taken from practical

experience).

In the Professional version it is moreover possible to set the phase

angles 

n j 3max = phase angle of the maximum three-pole short-circuit

current 
n j 3min = phase angle of the minimum three-pole short-circuit

current

n j 1max = phase angle of the maximum single-pole short-circuit

current

n j 1min = phase angle of the minimum single-pole short-circuit

current,

though the expanded value range must be enabled for that (in the

Tools menu à Settings à Editor settings).



85

5.3.7  Properties and equipment dialogue of low-voltage cables / wires

Properties of a cable / w ire connection at the low-voltage side

It is possible to change the

n designation of the connection 
n type of connection

n length of the connection

.

The "Busbar system" f ield and the respective info button

cannot be selected, because it is not a busbar connection

but a cable or w ire.

Equipment dialogue of a cable / w ire connection on the low-voltage side

It is possible to set, select or change the

n automatic dimensioning 

n designation 
n functional endurance

n material for conductor

n insulating material

n cable designs

n type of cable

n installation type

n f  tot = reduction factor

n permissible voltage drop along the connecting line

n temperatures for voltage drop and tripping condition

n cables per device

n number of cables

n length of the connection

n longest f ire area

n cross section of phase conductor

n if  applicable, reduced cross section of PE or PEN conductor

(depending on the selected system configuration).

Buttons next to the "Functional endurance and "Temperature" f ields

open the respective w indow s for the selection of relevant data

and settings.

Via the info buttons next to the f ields "Functional endurance",

"Installation type", "Reduction factor", "Temperature for voltage

drop" and "Temperature for disconnection condition", further

information about these issues is available, w hich is then displayed

in another w indow . Descriptions and view s referring to this topic

can be found in this section below .

Functional endurance

In the w indow  w hich is displayed w hen you click the button next

to the "Functional endurance" f ield, you can select w hether the

corresponding cable is to be laid

n ignoring the functional endurance criterion,  
n w ith a f lame-proof enclosure

n or as a cable w ith integrated functional endurance

.

In addition, the functional endurance category can be selected.
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You can call up more information about functional endurance using

the info button next to the "Functional endurance" f ield.

Basic information about the functional endurance topic and its

consideration in netw ork design using SIMARIS softw are tools can

be found in the Technical Manual, w hich you can access using

the Help menu  à "Technical manual".

As soon as you have made the selection as to "f lame-proof

enclosure" or "integrated functional endurance", the temperatures

w ill be set to the recommended values. These values, how ever,

can be called up clicking the "Temperatures" button and can be set

manually, too, in the w indow  w hich is then displayed.

If cables w ith integrated functional endurance w ere chosen (see

above), only matching cable designs w ill then be available for

selection in the "Cable type" f ield.

It is necessary for dimensioning to know  the length of the longest

f ire area, since this value goes into the calculation as "the w orst

case". To this end, you must define the length of the longest f ire

area in the appropriate data f ield, w hich is marked by  as long

as the value "0" is show n there. 
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In the w indow  of the "Installation type" info button, you can f irst

select 

n the cable type  
n and an installation type suitable for this cable type.

Depending on the selection made here, relevant data is provided

for selection in the other f ields. This means that depending on the

selected cable type you can define

n the arrangement in the single-core system 
n the installation type

n the installation site

n additional values.

For your information, the descriptions relevant for this selection,

including graphical representations, are displayed in the bottom

part of the w indow .

An overview  of frequently used "Installation types of cables and

lines" can be found in the corresponding section of the Technical

Manual for the SIMARIS softw are tools, w hich you can access

using the Help menu  à "Technisches Handbuch" öffnen

können.

You can set the ambient temperature to be used for determining

the reduction factor in the info button w indow  about the "Reduction

factor". Depending to your input, this entry w ill be adjusted

automatically and displayed in the same w indow .

In addition, you can specify the number of parallel cables here, i.e.

you can factor in an accumulation of cables and w ires this w ay.

Enter the sum of recently edited cables/lines plus the ones w hich

are be laid in parallel to them as the value for the number of parallel

cables. When you enter single cores, this summation only

considers the number of 3-phase or AC circuits.

More information about the "Accumulation of cables/lines" can be

found in the corresponding section of the Technical Manual for the

SIMARIS softw are tools, w hich you can access using the Help

menu  à "Technical manual".

Information about the various protection options for parallel cables

in the feed-in circuit can be found in the section Properties of

circuits  à "Properties of circuits for infeed and distribution".

Further details can also be found in the section "Parallel Cables in

Netw ork calculation and System Planning" of the Technical Manual

for the SIMAARIS softw are tools, w hich you can access using

the Help menu  à "Technical manual".
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In the w indow  that is displayed, w hen the "Temperatures" button is

clicked, you can set the temperature to be used for calculating the

voltage drop as w ell as the temperature for the disconnection

condition.

If you have selected "functional endurance" for the cable/line

section, you can additionally set the temperature to be assumed for

the voltage drop and the disconnection condition in case of f ire.

If you have chosen cables w ith integrated functional endurance,

you can call up the f ire load curve that helps you select the

temperature to be set. You do so by clicking the Info button next to

the drop-dow n menu that allow s to select the temperature for the

voltage drop or for the disconnection condition in case of f ire.

Installation type

You can specify the installation type in detail by clicking the Info

button next to the "Installation type" f ield. In the w indow  that is now

displayed you can select the cable type and installation type, and in

addition to this, further properties dependent on the selected

installation type. The diagram below  the selection f ields then

displays a draw ing and description matching your selection. Or,

you can make your selection by clicking the matching diagram. In

this case the data f ields are f illed automatically according to your

selection.
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Reduction factor

Adjusting the reduction factor based on the selected installation type

is possible by clicking the Info button next to the "Reduction factor"

f ield. In the w indow  that is now  displayed you can – besides

adjusting the specif ication for the installation type – also enter data

for the harmonic content, so that its impact on the reduction factor

can then be taken into account in the calculation.
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5.3.8  Properties and equipment dialogue of low-voltage busbar
connections

Properties of a busbar connection at the low-voltage side

It is possible to change the 

n designation of the busbar 
n type of connection

n length of the connection through the busbar system

Equipment dialogue of a busbar connection at the low-voltage side

It is possible to set, select or change the

n designation 
n functional endurance

n busbar system

n material for conductor

n mounting type

n degree of protection

n Ie = rated current

n busbar configuration

n f  tot = reduction factor

n permissible voltage drop/connection

n temperatures for calculating the voltage

drop and disconnect condition

n length of the connection through the busbar

system

n longest f ire area

Moreover, the values 

n Un max = maximum rated voltage 
n Iz = permissible load

n Icw  = rated short-time w ithstand current

The info buttons next to the"Functional

endurance", "Busbar system" and "Reduction

factor" f ields allow  further information about

these topics to be called up and displayed in

another w indow . 

Having clicked the "Functional endurance"

button, you can select in the w indow  then

displayed, w hether the respective busbar line is

to get a f lame-proof enclosure or not.

In addition, the fuantional endurance class

w hich is required can be set here.

Note: Functional endurance can only be

factored in for busbar systems for pow er

transmission in SIMARIS design, meaning only

the BD2, LD and LX systems. If you have

previously selected another busbar system for

the respective line, your selection w ill

automatically be rejected and changed to a

busbar system w hich meets the functional

endurance classif ication.
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As soon as you have made the selection

"flame-proof enclosure", the temperatures w ill

be set to the recommended values. These

values, how ever, can be called up clicking the

"Temperatures" button and can be set manually

in the w indow  w hich opens after clicking this

button.

Using the info buttons next to the "Functional

endurance" f ield, you can call up a brief

explanation of this topic.

Basic information about the functional

endurance topic and its consideration in

netw ork design using SIMARIS softw are tools

can be found in the Technical Manual, w hich

you can access using the Help menu  à

"Technical manual".

In the w indow  of the "Reduction factor" info

button, you can moreover set the ambient

temperature w hich is to be included in the

calculation of the reduction factor. This w ill be

adapted automatically based on your

specif ication and displayed in the same

w indow .

How ever, if  you have selected a f lame-proof

enclosure for the busbar line, the reduction

factor w ill be determined by the program and

cannot be set manually any more.

In the w indow  that is displayed, w hen the

"Temperatures" button is clicked, you can set

the temperature to be used for calculating the

voltage drop as w ell as the temperature for the

disconnection condition.

If you have selected "functional endurance" for

the busbar line, you can additionally select the

temperature for the voltage drop and the

disconnect condition w hich is to be assumed in

case of f ire. 

If  a f lame-proof enclosure w as selected in the

"Functional endurance" f ield, an appropriate

area must be selected in the "Longest f ire area"

field, since this value goes into the calculation

as the "w orst case".

The setting is made w ith the tw o sliders. In the

tw o f ields below  the sliders, 

n the beginning of the longest f ire area

referred to the beginning of the entire busbar

line 
n and the length of the longest f ire area 

w ill be show n as values.

31
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If tw o busbar lines are lined up in the netw ork

diagram, a common fire area may be defined for

them, i.e. across the connecting point of the

second busbar line.
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5.3.9  Properties and equipment dialogue of low-voltage switching devices

Properties of a low-voltage switching device

It is possible to change the 

n designation of the sw itch 
n sw itch type. 

Equipment dialogue of a low-voltage switching device

It is possible to change or select the

n designation 
n earth fault detection.

In the case of dimensioned devices and supplementary devices, this w indow

also displays their order numbers and technical data.

By clicking the "Catalog..." button, a new  w indow  is opened, displaying

further technical data of the dimensioned sw itching device.

It is also possible to change the data displayed there and thus select a

different sw itching device by clicking the "OK" button.

Another w ay to change the suggested device, e.g. to a device from a

different product group, is the selection via the product groups tree

displayed in the left part of the catalogue w indow . A device selected in this

w ay must then be specif ied w ith technical data via the attributes displayed

on the right and can f inally be applied by clicking the "OK" button.

General handling of a catalogue:

n In the left part of the w indow  you can select the required sw itching

device type w ithin the product groups, w hich you can then specify w ith

the help of the attributes displayed to the right and apply to your netw ork

diagram by clicking the "OK" button.  
n Another option is to search specif ically for a particular device by

entering the body of or the entire order number in the search f ield at the

top left. If  searching w ith an order number body, the corresponding

branch of the product tree is activated and the suitable attributes are

displayed on the right and are already selected as far as possible

according to the order number body.

Furthermore, the catalogue provides the option to save frequently used

sw itching devices as favourites to be able to quickly add them to a netw ork

diagram later.

5.3.10  Properties and equipment dialogue of equivalent electric circuits

Properties of an equivalent electric circuit (impedance)

There are no properties displayed for such circuits.

Equipment dialogue of an equivalent electric circuit (impedance)
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It is possible to change the

n designation 
n zero or positive phase-sequence system of the phases, N and

PE(N) conductors

n specif ication w hether the voltage drop across the equivalent

impedance is relevant for the overall calculation

n specif ication w hether the equivalent impedance is relevant for a

short-circuit.

Formula symbols used:

R0 = resistance in the zero phase-sequence system

R1 = resistance in the positive phase-sequence system

X0 = reactance in the zero phase-sequence system

X1 = reactance in the positive phase-sequence system

Z0 = impedance of the zero phase-sequence system

Z1 = impedance of the positive phase-sequence system
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5.3.11  Properties and equipment dialogue of a stationary load

Properties of a stationary load

It is possible to change the

n designation 
n rated current

n active pow er

n place of installation.

Equipment dialogue of a stationary load

It is possible to change or set the

n designation 
n number of poles (type of netw ork) and thus the phases or vice

versa

n In = nominal current

n P = active pow er, electric.

n cos(j) = pow er factor

n Un = nominal voltage

n ai = capacity factor

n type of load, ind./cap.

n place of installation.

Explanation:

The capacity factor ai describes the load share w hich is taken into

account in the energy balance of the netw ork. The protective device

and the cable/busbar are rated for nominal current, how ever, upstream

devices/cables/busbars... transformers only taking account of this

factor. This means that the capacity factor correlates w ith the

simultaneity factor referred to the load.

If a capacity factor (ai) is selected for the loads and a simultaneity

factor (gi) at distribution board level, these factors are multiplied in the

energy report.

5.3.12  Properties and equipment dialogue of motors

Properties of a motor

It is possible to change or set the

n designation 
n motor type

n type of construction, if  applicable

n starting mode, if  applicable

n Pmech = mechanical pow er
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Equipment dialogues of motors

Depending on the type of motor, the setting options differ; see examples

on the left.

It is possible to change or set the

n designation 
n motor type

n type of construction

n starting mode

n type of co-ordination

n overload relay

n Pmech = active pow er, mechanical

n Un = nominal voltage

n In = nominal current

n cos(j) = pow er factor

n h = eff iciency 

n starting current ratio

n R/X ratio = resistance / reactance

n startup class

n capacity factor ai

n factor of energetic recovery system.

The info button linked to the "Type of co-ordination" f ield, makes further

information about this subject available and displays it in another

w indow . This information can also be found in the section Adding f inal

circuits  w hich describes, among other things, how  to add motors to

the netw ork diagram.

Explanation:

The capacity factor ai describes the load share w hich is taken into

account in the energy balance of the netw ork. The protective device

and the cable/busbar are rated for nominal current, how ever, upstream

devices/cables/busbars... transformers only taking account of this

factor. This means that the capacity factor correlates w ith the

simultaneity factor referred to the load.

If a capacity factor (ai) is selected for the loads and a simultaneity

factor (gi) at distribution board level, these factors are multiplied in the

energy report.

Via the info button next to the "Startup class" f ield, further information

about this issue is available and displayed in another w indow . 

64
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5.3.13  Properties and equipment dialogue of frequency converters

Properties of a frequency converter

It is possible to change or set the

n Capacity factor

n Quantity

n Target of dimensioning

n Selectivity interval, if  applicable

n Designation
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Equipment dialogue of frequency converters 

It is possible to change or set the

n Installation type

n Designation 
n Use

n Performance

n EMC provision

n Overload profile
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5.3.14  Properties and equipment dialogue of switching devices of motor
starter combinations

Properties of an upper switching device in a motor starter combination

It is possible to change or select the

n designation 
n sw itch type.

Equipment dialogue of an upper switching device of a motor starter combination

It is possible to change the 

n designation 

Since motor starter combinations are type-tested device combinations

w hich must not be changed, the technical data of the dimensioned

sw itching devices are only displayed.

In contrast to other equipment dialogues for sw itching devices,

therefore only the combination’s designation can be changed in this

equipment dialogue once it has been selected and dimensioned (direct

on-line starter, reversing mode, star-delta starter or soft starter). It is not

possible to call up a catalog to change the selected devices.
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5.3.15  Properties and equipment dialogue of charging units

Properties of a charging unit

It is possible to change/specify the 

n designation 
n nominal current of connector In.

 

Equipment dialogue for a charging unit

It is possible to change or set the

n designation 
n charging unit type

n selection w . or w /o integrated protection

n number of poles

n phases

n nominal current of connector In

n pow er factor cos(j)

n capacity factor ai

n inductive/capacitive load

n place of installation.

 

5.3.16  Properties and equipment dialogue of capacitors

Properties of a capacitor

It is possible to change/specify the 

n designation 
n reactive pow er per stage (=module)

n number of capacity modules 

n modules sw itched on.

Equipment dialogue of a capacitor

It is possible to change or set the

n designation 
n Q = reactive pow er per stage

n number of capacity modules 

n modules sw itched on

n Un = nominal voltage

n nominal frequency

n pow er loss.
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5.3.17  Properties and equipment dialogue of dummy loads

Properties of a dummy load

It is possible to change the

n designation 
n In = nominal current

n P = active pow er, electric.

Equipment dialogue of a dummy load

Equipment dialogue of a dummy load

It is possible to change or set the

n designation 
n In = nominal current

n P = active pow er, electric.

n cos(j) = pow er factor

n type of load, ind./cap.

5.3.18  Properties and equipment dialogue of lightning current and
overvoltage protection devices

Properties of a lightning current and overvoltage protection device

It is possible to change the

n designationfuse 

n sw itch type

n arrester name

n arrester type

.

Equipment dialogue of alightning current and overvoltage protection device
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Equipment dialogue of alightning current and overvoltage protection

device

It is possible to change or select the

n designation of a lightning current protection device 

n fuse selection (Catalogue)

n fuse base selection (Catalogue)

n arrester name

n arrester type (Catalogue)

.

5.4  Dimensioning and message list
5.4.1  Introduction
Having selected and placed the elements required for the project to be planned on the netw ork diagram, you can start dimensioning. To be able to

run a dimensioning process, it is f irst of all necessary to define the operating modes for the netw ork, because all sw itching and protective

devices w ith pow er sources contained in the circuits as w ell as all couplings are considered open directly after their creation, and therefore a

current f low  through the equipment is not possible. Only after the user has set the status of the individual sw itching and protective devices

depending on the operating mode in such a w ay that a current f low  is possible, calculations, dimensioning and testing w ill be possible in SIMARIS

design.

The operating modes can be defined

n either directly via the  icon for defining the operating modes  

n or by starting dimensioning of the entire netw ork via the  icon, because this also starts the dialogue for defining the operating modes.

To dimension single circuits  or subnetw orks, it is not only necessary to select the corresponding elements in the netw ork diagram but

also to define the operating modes via the  icon in advance, because these icons only become active w hen the operating modes have

been defined, i.e. a current f low  through the elements is possible. These icons w ill, of course, also be active after dimensioning of the entire

netw ork has been completed, because this also included the definition of the operating modes.

5.4.2  Dialogue of the operating modes
A basic introduction to this topic can be found in the chapter Operating modes  w ithin this Help

manual (icon bars  à "Netw ork Design" à "Operating modes").

11

9



103

n The "Operating modes" dialogue show s all settable sw itching devices of the project, w hich are

all open at f irst. You can now  change the states of the infeed circuits and couplings here, i.e.

define the sw itch positions required for the respective operating mode. This means that the

sw itches show n in the Operating modes dialogue are used to connect or disconnect circuits

depending on the operating mode. 
n Operating modes can be activated / deactivated in order to show  calculation results of the

separate operation modes.

Caution:When starting the automatic dimensioning, only activated operating modes are taken

into account.

n In the professional version, sub-distribution systems can be sw itched, too, provided that they

are additionally supplied by a directed coupling. 

n All other circuits are considered as alw ays closed.

n Starting from the f irst operating mode displayed by the program at the beginning, further

operating modes can be defined by clicking the "Duplicate" button under an already created

operating mode in the Operating modes dialogue so that a copy of the respective operating

mode is created, for w hich you can then define a new  designation and make sw itch settings

that differ from the operating mode w hich w as defined f irst.

n More operating modes can be defined that w ay.

n By clicking the "Delete" button, the respective operating mode is deleted from the dialogue.

n Non-permissible combinations of sw itch positions are signalled by red error messages, e.g. 

.

Notes: 

n As every operating mode is evaluated during calculation, the calculation w orkload increases

w ith the number of defined sw itching states. You should therefore take care that no identical

operating modes are defined. The program does not check w hether identical operating modes

have been created. 
n If  there are tw o sw itches in a circuit (upstream and dow nstream of the cable/busbar), the

dialogue displays only one sw itch; as a series connection is given here, it is irrelevant for the

calculation w hich of the tw o sw itches is open.

n Complex netw orks designed w ith SIMARIS design professional may possibly lead to the

problem that some cross connections of couplings cannot be displayed graphically in the

dialogue any more. In this case, connections are symbolised by tw o triangles/arrow s w hich

are marked w ith an identical number. The arrow s indicate the direction of current f low .
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5.4.3  Dimensioning
The prerequisite for dimensioning equipment is 

n a current f low  in at least one operating mode 

n and the selected option "Automatic dimensioning" for the equipment to be dimensioned. 

n Equipment marked by the padlock symbol w ill not be considered for automatic dimensioning;

also see the explanation in the section Properties of circuits and equipment  of the

equipment dialogues. 

There are three buttons for the automatic dimensioning of the follow ing items of equipment:

transformers, generators, sw itching and protective devices, cables and busbars. 

n By clicking the "Dimension all circuits" icon, dimensioning of the entire created netw ork is

started. If  no operating modes have been defined yet, this can be done w ithin the scope of

dimensioning because the Operating modes dialogue is started automatically at the beginning

of the dimensioning process. The dimensioning result can not only be the determination of the

required data but also messages indicating various problems during the dimensioning process,

w hich w ill be explained in the follow ing section. 

n By clicking the "Dimension circuit" icon, the circuit currently selected in the netw ork diagram is

dimensioned. 

n By clicking the "Dimension selected sub-netw ork" icon, the circuit currently selected in the

netw ork diagram and all dow nstream circuits are dimensioned, except for directed couplings. 

Note on the dimensioning of busbar

systems

n Busbar systems are tested for thermal short-circuit strength and overload protection. Dynamic

short-circuit strength is present if  both attributes are fulf illed (see IEC 60364-4-43 Clause 434).

Dynamic short-circuit strength is not tested. 
For a "Note on the dimensioning of 8PS busbar systems", please refer to the corresponding

sectionof the Technical Manual for the SIMARIS softw are tools w hich you can access using the

Help menu  à "Technical manual".

dimensioning of pow er transmission and

pow er distribution lines

For an "Overview  of pow er transmission and pow er distribution lines", please refer to the

corresponding section of of the Technical Manual for the SIMARIS softw are tools w hich you can

access using the Help menu  à "Technical manual".

Calculation standards The "Standards for calculations in SIMARIS design" are listed in the corresponding section in the

Technical Manual for the SIMARIS softw are tools w hich you can access using the Help menu

 à "Technical manual".

Additional protection by RCDsin

accordance w ith 

DIN VDE 0100-410 (IEC 60364-4-41)

Explanations on the "Additional protection by RRCDs"in accordance w ith DIN VDE 0100-410 (IEC

60364-4-41) and national deviations from this standard can be found in the corresponding chapter

of the Technical Manual for the SIMARIS planning tools w hich you can access using the Help menu

 à "Technical manual".
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5.4.4  Message list
Dimensioning can produce four types of status messages displayed in the message list below  the netw ork diagram; essential characteristics

of these messages have already been described in the section Message list  (Netw ork design user interface à Message list).

Above the list, the total number of messages available is displayed and an icon also indicates the status of all messages.

n Circuits are contained in the projects w hich w ere not or cannot be checked (e.g. unloaded circuits).  

n There are errors in the project. 

n All circuits w ere checked and there are no faulty circuits. Warnings, notes and dimensioning errors are not separately

recorded and associated to this node. 

n Primarily, the icon for circuits w hich w ere not or cannot be checked w ill be displayed here. 
n If  there are no such circuits, the "error" icon w ill be displayed.

n If  there are no errors either, the netw ork diagram w ill be classif ied as OK w ith a green checkmark.

n How ever, possibly existing w arnings, info messages and dimensioning errors w ill be ignored. This means they must be checked in the

list itself and follow ed up and/or corrected by appropriate action in the configuration itself.

In the list itself, the follow ing icons are displayed w hich indicate the kind or status of the problem or error involved:

n General messages and information is displayed ifcircuits are contained in the projects w hich w ere not or cannot be

checked (e.g. unloaded circuits). 

n Error messages result in the abortion of the calculation/dimensioning process. This means these errors must be corrected by

changing the arrangement of elements or by changing property settings (on the left of the netw ork diagram) or in the

equipmenet dialogue of the respective element in such a w ay that dimensioning is then possible. 

n Warning messages indicate that default settings or standards have not been observed. This means that a dimensioning run

w as performed, but it must be ensured that the additional requirements as detailed in the existing w arning messages are met.

Therefore, the user should solve the existing problems by changing the configuration or the settings. 

n Dimensioning errors indicate an unsuccessful dimensioning process. Here, it is also necessary to change the configuration

and the settings to make dimensioning possible. 
The reason for such dimensioning errors may as w ell be the error messages listed, for example, if  the transformer capacity

is not suff icient, or a suitable sw itching device w as not found.

n Information messages contain general information or hints on the elements and thus support the user in checking his

configuration, e.g. w ith regard to completeness. 

47
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Apart from the icon w hich indicates the status of the message, the

n designation of the respective element 
n and the message text 

are displayed.

n When a message is selected in the message list, the graphic of the netw ork diagram focuses on this element and it is pre-selected. 

 
n If  several messages exist for one element, they are highlighted in grey in the message list as soon as one of these messages or the

element in the netw ork diagram has been selected.

Double-clicking on the message opens the equipment dialogue of the respective element for a fast correction of the faulty state.
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6  Output and Data Transfer
6.1  Output types and options
6.1.1  General information

To prepare the output, select the output types w hich you require for

documentation of your project in the list at the top left.

The follow ing section of this Help w ill explain the contents of the

respective output types in more detail.

Some output types allow  further individual settings to be made in the

output options. A description of these individual setting options can

be found in the follow ing sections in the context of the output type

description.
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The netw ork diagram you created is also show n in the program step

"Project output", see the graphics w indow  in the right part of the

screen.

The follow ing changes in the netw ork diagram are still possible:

n Changing the arrangement (placement) of objects 
n Changing the displayed netw ork diagram view  (device

parameters, load f low  / load distribution, short-circuit load, energy

report)

The functions required for these changes are activated on the tool

bar above the netw ork diagram and can be used accordingly.

How ever, it is no longer possible here

n to redimension the netw ork 
n to call the equipment dialogues of the elements to change values

there

n to call the Catalogue to change the device selection there.

Correspondingly, these functions are deactivated on the tool bar.

The output can be started by clicking the "Start Output" button. 

n First, a w indow  containing general notes as to the results

obtained and the output created is displayed. 
n Moreover, this w indow  lists any still existing error messages,

w arning messages and information messages. It is possible to

document these in the output by checking the respective f ield.

n Only after the information contained in this w indow  has been

confirmed by clicking the "OK" button, is the creation of the

documentation started according to the selection made. 
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6.1.2  Output types

Output of a project documentation

When the output type "Project documentation" is selected, it

is possible to select

n the paper size (A4 or Letter) 
n the integration of a company logo (.png, .jpg or .jpeg

format).

n the type of cable data specif ication (Metric or AWG/

kcmil).

 

This output type comprises

n a cover sheet stating the master data, customer data

and comment on the project 
n an overview  of the general presettings and netw ork

parameters as w ell as those made for medium and low

voltage

n a graphical representation of the netw ork operating

modes defined for the netw ork calculation as w ell as for

dimensioning

n a device list subdivided in the categories

– pow er sources

– sw itches / fuses

– connections and busbar trunking systems

– equivalent impedances

– Loads

These categories are each further subdivided according

to the device types included in the project and

appertaining to the respective category.

n a list of the used formula symbols w ith explanations

n a list of the standards used for the calculation.

The complete document is output in a modif iable .rtf  format

and automatically opens your installed w ord processing

program. The f ile generated in this w ay can then be saved;

this can also be done in the Word format (.doc) w hich

considerably decreases the f ile volume.

Output of a device list, sorted by distribution

This output type generates a table listing all dimensioned sw itching devices as w ell as transformers and

generators and for these the follow ing information:

n designation of the distribution board (from the netw ork diagram) to w hich the item of equipment is assigned 
n Order number

n details on the device type

n required quantity.

n required quanitity

The list is created in .csv format and automatically opened w ith a program suitable for displaying, e.g. Microsoft

Excel.

Output of device settings

This form of data output creates a list of medium-voltage protective devices and a list of low -voltage

protective devices in w hich all relevant settings of those devices included in the netw ork diagram are listed.

The list contains the follow ing information:

n designation from the netw ork diagram 
n Order number

n Settings relevant to the respective device type
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The list is created in .csv format and automatically opened w ith a program suitable for displaying, e.g.

Microsoft Excel.
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Output of a list of busbars

This output type generates a table listing all dimensioned busbar systems and for these the follow ing

information:

n Designation taken from the netw ork diagram 
n order number (only body!)

n length in m

The list is created in .csv format and automatically opened w ith a program suitable for data display, e.g.

Microsoft Excel.

Output of a list of cables

When the output type "List of cables" is selected, it is possible to select

n the type of cable data specif ication (Metric or AWG/kcmil). 
 

This output type generates a table listing all dimensioned cables and for these the follow ing information:

n Designation taken from the netw ork diagram 
n cross section in mm2 or aw g/kcmil

n type of cable

n length in m

n quantity

The list is created in .csv format and automatically opened w ith a program suitable for data display, e.g. Microsoft Excel.

Output of short-circuit currents 

This output type generates a table listing

n the relevant short-circuit currents 
n respective phase angles

n impedances

n reactances

n loop impedances

for all dimensioned items of equipment.

The list is created in .csv format and automatically opened w ith a program suitable for data display, e.g.

Microsoft Excel.
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Output of selectivity

When the output type "Selectivity documentation" is selected, it is possible to select

n the paper size (A4 or Letter) 
n the integration of a company logo (.png, .jpg or .jpeg format).

 

With this output type, a data sheet is generated for each configured and dimensioned sw itching device, as

far as possible, containing

n the designation of the circuit to w hich the device belongs 
n the designation of the device in the netw ork diagram

n the selectivity evaluation (fully selective, partially selective) à only w ith SIMARIS design professional

n the sw itch settings

n a chart w ith

� the tripping characteristic of the respective sw itching device w ith the tolerance bands

� the envelope curves of the upstream and dow nstream protective devices

� the specif ication Ikmin and Ikmax

� the selectivity limits à only w ith SIMARIS design professional

 

The last page of this output show s the disclaimer, w herein the devices w hich w ere not considered w ithin

the selectivity evaluation are listed.

The selectivity document is output in a modif iable rtf format and automatically opens your installed w ord

processing program. The thus created f ile can then be saved; this can also be done in the Word format

(.doc) w hich considerably decreases the f ile volume.

Depending on the printer w hich is available, the document may be output in colours or black&w hite. The

corresponding setting options can be found in the

Tools menu à Settings à Selectivity Settings à I-t diagram printer colours.

Output of a network diagram (PDF)

When the output type "Netw ork diagram (PDF)" is selected, it is possible to select

n the paper size of the .pdf  
n the representation of the padlock and key symbols

n the changeover to the output of all view s (not only the currently displayed view ).

 

For the selection of the paper size of the .pdf, the selected original size (format selected for the netw ork

diagram) as w ell as the formats A4 landscape and portrait, A3 landscape and portrait, A2 landscape, A1

landscape and A0 landscape are provided for selection. If  a smaller/different format than the set original

format is selected, the netw ork diagram is spread over several pages w hich add up to the overall graphic

again w hen being properly apposed. If necessary, a .pdf created in original size can also be spread over

several pages w hen being printed out so that the overall graphic can be displayed w ith a suff icient font

size by apposing the individual pages.

n This data output generates a .pdf f ile w hich contains the entire netw ork diagram. By changing the

netw ork diagram view  it is possible to generate netw ork images w ith different technical data, or by

selecting the "All view s" option to generate the entirety of all possible view s (standard view s and the

view  defined using the Tools menu  à "Settings" à "Configurable Netw ork Diagram Output").

 By additionally activating the "Selectivity" icon w hen the .pdf  f ile is  generated, the markings  displayed

in the graphics  in green and yellow  (only  in the professional  version)  of  the  fully  and  partially  selective

elements w ill also be output, i.e. they w ill be visible in the PDF.

To  display  the  created  .pdf  f ile,  a  suitable  program  must  be  installed  w hich  w ill  then  be  started

automatically.

25
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Output of a network diagram (DWG/DXF)

n This output option allow s to generate .dw g or .dxf f iles w hich contain the current netw ork diagram and

the currently enabled single-line diagram view . More single-line diagrams can either be separately

selected by enabling the desired view  and starting data output, 
n Or, all view s (standard view s and the view  defined using the Tools menu  à "Settings"

à"Configurable Netw ork Diagram Output") can be generated at once by selecting "All view s" and

starting the output.

All of these f iles can be read into CAD or CAE tools for display or further processing.

If the "Selectivity" icon is activated w hen this output is generated, the green and yellow  markings  indicating

fully  and partially  selective elements  w ill be displayed, but they  w ill not be included in the exported .dw g

and .dfx f ile.

Output of the SIMARIS transfer file (SX)

In this output, you can create an export f ile (f ilename.sx) w hich

contains all relevant data of the dimensioned items of equipment w hich

are necessary for further editing the project w ith SIMARIS project.

This means that you can easily and quickly create a specif ication of

w ork and services and determine a budget for the pow er distribution

plant configured in SIMARIS design by importing this f ile into SIMARIS

project.

25
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6.2  Data transfer
Data transfer to SIMARIS project

To determine a budget and also the space requirements for a pow er distribution plant dimensioned w ith SIMARIS design professional, you can

create a transfer f ile filename.sx w ith SIMARIS design by selecting the output type "SIMARIS exchange f ile (SX)", starting the export by

clicking the "Start Output" button and saving the f ile in the desired path. The thus created f ile can then be imported in SIMARIS project. 

Procedure in SIMARIS project: Directly select "Import from SIMARIS design" in the start w izard w hen starting the program or, if  the program is

open, via the menu item Project à Import from SIMARIS design and then select a SIMARIS design f ile w ith the extension .sx by clicking the

"Brow se..." button. By clicking the "Next" button, the SIMARIS design f ile is imported and w hen subsequently clicking the "Finish" button the

corresponding view s and lists are created. Depending on the size of the project, this process might take some time. Based on the data applied

from SIMARIS design, the required plants are directly generated, listed in the project tree and displayed in the program step "System Planning"

as parts list or front view . Unrecognized components are marked or listed correspondingly. Detected protective devices at outgoing feeders of

busbar systems are transferred to the respective tap-off units.

Subsequently, the individual, automatically generated plants can be post-processed as required.
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7  Technical Background of the Systems
7.1  Medium voltage switching and protective devices
If  you select a transformer w ith medium voltage as infeed, dimensioning of the medium-voltage sw itching devices, as selected, is based on one of

the follow ing devices offered by Siemens:

n medium-voltage circuit-breakers 
n 7SJ6, 7SJ82 medium-voltage protective devices 

n Reyrolle 7SR11/12 medium-voltage protection devices

n sw itch disconnectors w ith medium-voltage fuses (SIBA).

7.2  Generators
Generators are primarily dimensioned on the basis of preset technical data. You can, how ever, replace this technical data, e.g. by entering

manufacturer-specif ic data.

As dimensioning result, you w ill obtain the technical data for generator rating, w hich you can use as a basis for product procurement.

7.3  Transformers
Transformer dimensioning is primarily based on those transformers w hich are available from Siemens. You can, how ever, use transformers from

other manufacturers in your planning, by entering their technical data as transformer properties.

SIMARIS design currently provides GEAFOL 4GB cast-resin transformers for dimensioning. The technology package for Brazil contains local

transformer data, type designations, and technical data.

7.4  Low voltage switching and protective devices
Dimensioning relies on the comprehensive low  voltage product portfolio of sw itching and protective devices offered by Siemens. This means, you

w ill obtain a list containing the specif ic order numbers of the devices suggested as dimensioning result.

Since the product portfolio varies from region to region, the specif ic devices w ill alw ays be determined on the basis of the portfolio that is

assigned to the selected country setting. This may not include all of the product groups listed below .

The follow ing product groups are kept in SIMARIS design:

n air circuit-breakers, type SENTRON 3WL, 3WN and 3WT 
n moulded-case circuit-breakers, type SENTRON 3VL, 3VT and 3RV

n moulded-case circuit-breaker, type 3VA1 up to 160 A, 3VA2 up to 630 A

n circuit-breakers for motor protection, 3VU

n compact feeder, 3RA6 direct starter

n SENTRON 3KA, 3KD, 3KE, 3KL and 3KT sw itch disconnectors

n ERGON sw itch disconnectors

n S32 sw itch disconnectors

n SENTRON 3KM sw itch disconnectors w ith fuses

n ERGONFUSE sw itch disconnectors w ith fuses

n SENTRON 3NP fuse sw itch disconnectors

n SENTRON 3NJ in-line fuse sw itch disconnectors

n miniature circuit-breakers, type 5SJ, 5SL, 5SY, 5SX, 5SP and 5SQ

n residual current protective devices, type 5SM, 5SU and 5SV

n fuse bases, type 5SD, 5SF, 5SG

n 3NH fuse bases

n 3NA fuses

n 5SA, 5SB, 5SC, 5SD8 and 5SE fuse links

n 5SD7 lightning and overvoltage protection devices 

n 3LD2 sw itch-disconnector

n ...

Detailed product data can be found in the corresponding catalogues of I BT LV.
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7.5  Cables
The cables configured w hen creating the netw ork diagram are only factored in electrically w hen a dimensioning process is performed in SIMARIS

design. This means that lists of cables required for the project w ill be output, but only w ith their standard designations, not w ith specif ic order

numbers.

You can choose betw een the output of cable data specif ication in metric form acc. to German standard or acc. to American standard (AWG =

American Wire Gauge) in kcmil.

Note: 1 kcmil » 0.5067 mm2 à 2 kcmil  » 1 mm2

7.6  Busbar systems
In SIMARIS design, the busbar systems required for creating the netw ork diagram are configured and dimensioned on the basis of the product

portfolio and technical data of SIVACON 8PS busbar trunking systems. These busbar trunking systems can meet all load demands reliably and

safely w ith a complete product range for the use from 25 A up to 6,300 A. Their high short-circuit rating and low  fire load as w ell as type-

tested connections to SIVACON sw itchgear and GEAFOL transformers ensure highest safety. The systems require little space, allow  for a

clear netw ork design and can be installed quickly and retrofitted or adapted w ithout any problems. The system also comprises communication-

capable components. Improved safety is ensured via the high short-circuit rating, the low  fire load and also via the type testing.

BD01 system n For the pow er supply of electrical tools in w orkshops as w ell as lighting systems. 
n Use from 40 A up to 160 A 

n Rated operating voltage Ue max 400 V 

n Degree of protection up to IP55

BD2 system n For pow er transmission and distribution in the medium-voltage range in off ice buildings and transfer lines in all

industrial application areas. 
n Use from 160 A up to 1,250 A

n Rated operating voltage Ue max 690 V 

n Degree of protection up to IP55

LD system n For pow er distribution and transmission of high currents in exhibition halls, in the automotive industry, heavy

industry and on ships. 
n Use from 1,100 A up to 5,000 A 

n Rated operating voltage Ue max 1000 V

n Degree of protection IP34/IP54

LI system n f lexible pow er distribution for high currents in the industry and safe pow er transmission from the transformer to the

main distribution in buildings 
n Use from 1,100 A up to 5,000 A 

n Rated operating voltage Ue max 1000 V

n Degree of protection up to IP55

LX system n Use from 800 A up to 6,300 A 
n Rated operating voltage 

n Degree of protection up to IP55Ue max 690 V

n Degree of protection up to IP55

LR system n Epoxy cast-resin version; the compact design for open air use. 
n Use from 630 A to 6,300 A

n Rated operating voltage Ue max 1000 V

n Degree of protection IP68
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The overview  show s the busbar trunking

systems available at Siemens.
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The overview  states the designations of the

various components of a busbar trunking

system taking the BD2 system as an

example.

7.7  Distribution boards
SIMARIS design only considers the busbar trunking systems directly as distribution boards (see section Busbar systems ). The required low -

voltage sw itchboards and distribution boards are only considered for dimensioning w ith regard to the required devices or loads. This means you

w ill not obtain any specif ic order numbers from SIMARIS design that w ould refer to the distribution boards necessary for plant design. This

information can, how ever, easily be obtained by exporting your project and then processing it in SIMARIS project, as described in the section Data

transfer .

7.8  Loads
Loads are only considered in SIMARIS design on the basis of the technical data preset or calculated. The data to be entered for specifying loads

vary according to the type of load. For more specif ic information about this topic, please refer to the section Adding f inal circuits and

alsoProperties and equipment dialogue of equivalent electric circuits  to Properties and equipment dialogue of lightning current and overvoltage

protection devices , w hich decribe the equipment dialogues for loads.
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